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About Kid Pix Deluxe 3D 
This revolutionary new Kid Pix puts feature-film quality 3D storytelling into the hands of kids. 
Video narration lets kids star in their own animated adventures, and easy path animations lets 3D 
characters interact on screen. Eye-popping 3D backgrounds, and a hundred video backgrounds 
provide a Hollywood setting. For ages 4 and up. Includes two pairs of red-blue 3D glasses!

Kid Pix Deluxe 3D supports all files created with Kid Pix Deluxe 3X and 3D editions for Mac. 

Kid Pix Deluxe 3D has two parts: 

The Paint Zone lets you create pictures with different art tools. •	

Slide Show lets you put pictures into a presentation with visual transitions and sounds. •	

In this chapter you will learn about: 

Kid Pix Deluxe 3D System Requirement•	 s 

Kid Pix Deluxe 3D — New Level of Creativit•	 y

Getting Starte•	 d 

The Kid Pix Deluxe 3D Paint Zone•	  

The Kid Pix Deluxe 3D Slide Sho•	 w 

Using the Menus•	  

Getting Help•	  

Removing Kid Pix Deluxe 3•	 D 

Kid Pix Deluxe 3D System Requirements 

Minimum system requirements: 

Microsoft•	 ® Windows XP SP3 or later, including Microsoft Windows 8

1 GHz Intel•	 ® processor or equivalent 

512 MB RAM •	

350 MB of free space to install and work with the application (in this case the Kid Pix 3D DVD •	
must be in the DVD drive in order to launch the application), or about 2.2 GB for full installation 

1024 x 768 display resolution, 32-bit color•	

Built-in or external video camera — for video recording•	

Microphone — for Sound Art Tools and recording narration•	

Internet connection — for publishing to YouTube™•	

DVD drive - for installation•	

Sound card - for sound and video playback.•	
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Kid Pix Deluxe 3D - New Level of Creativity
Join the creative world of Kid Pix Deluxe 3D and be amazed! 3D animations and 3D backgrounds are 
coming with astounding 3D stereographic effect and make your artwork have the same effect as a 
3D movie. You can make nearly every object move across the screen by drawing a path for it, place 
dozens of video backgrounds, narrate your stories dressed into a narration costume and even share 
your artwork with the World by publishing your video to YouTube.

Export with 3D Effects!

Generate true 3D movies for viewing with 3D glasses. Two pairs come in each box! For more 
information, see “Exporting Pictures with 3D Effects” on page 54.

3D animations!

Richly rendered fully 3D animated characters and objects have been added, each with their own 
unique story to tell.

3D backgrounds!

Set the scene with dozens of gorgeous new multi-layered 3D backgrounds!

Path animation!

Easy to use drag and drop tools let your characters walk, hop or fly around the screen. For more 
information, see “Path Animation Tool” on page 37.

Multi-level undo!

Undo Guy can fix just about anything, with multiple levels of undo and redo! For more information, 
see “Using Multi-Level Undo Guy” on page 24.

Flipbook button!

You can make stop-action “flipbook” films by adding slides directly to your Slide Show — without 
leaving the Paint Zone! For more information, see “Loading Pictures” on page 57.

Video narration!

Using the built-in or external camera on your PC, kids can not only tell the story in their own words, 
they can take part in it and be the star of their own movie! For more information, see “Video 
narration” on page 44.

Movie backgrounds!

A hundred video backgrounds provide a touch of Hollywood movie-making magic to your production, 
whether it’s a short clip or a feature length film. For more information, see “Adding movies to your 
picture” on page 43.

Narrator costumes!

With the video narration feature, kids narrate their own animated stories – dressed for the part with 
costumes ranging from an undersea diving bell to a full astronaut’s suit. For more information, see 
“Adding a frame to your movie” on page 45.
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Publish to YouTube!

Share your animated stories and adventures with just one friend or the whole world — without 
leaving Kid Pix Deluxe 3D. For more information, see “Publish to YouTube” on page 49.

Sounds!

Use dual audio tracks to add both narration and music to your stories! For more information, see 
“Double soundtrack” on page 42.
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Getting Started 

To install Kid Pix Deluxe 3D: 

Put the1. 	   Kid Pix Deluxe 3D DVD into the DVD-ROM drive. The AutoPlay dialog will prompt 
you to start the Autorun application. If you have the AutoPlay option turned off on your 
computer, open the Kid Pix Deluxe 3D disc with Explorer and double-click Autorun.exe.

Click the 2. 	  Install Kid Pix Deluxe 3D button. In the window that appears, click the Next 
button. 

Select either 3. 	  Home or School installation depending on where you use Kid Pix and click the 
Next button: 

With •	 Home installation, decide if you want to install only the Kid Pix application 
(Minimum install) or the application and its libraries as well (Full install). Select the 
Destination Folder, installation options you want, click the Next button, and proceed to 
step 5.

With Minimum installation, the program will be installed without its libraries. In this 
case, you will need to have the DVD disc in your computer to launch the program. For 
more information on this matter, see “Installing Kid Pix DVD Contents on page 10. 

With Full installation, Kid Pix Deluxe 3D will be installed with its all libraries. 

With •	 School installation, you can turn on or off the Login dialog, the startup movie, and 
the update notifications in Kid Pix. The application libraries are always installed. 

Note: You can always change these settings later by using the Kid Pix Preferences 
dialog. For more information, see “Setting Up Kid Pix Preferences” on page 67.

Select the 4. 	  Destination Folder, installation options you want and click the Next button.

Specify whether you want to create a shortcut or not. Click 5. 	  Install button and wait until the 
installation is complete. 

Choose whether or not you want to read Kid Pix Deluxe 3D README file right away, and then 6. 	
click Finish. 
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To launch Kid Pix Deluxe 3D: 

From the Start menu choose All Programs, and then choose Kid Pix 3D from Kid Pix 3D submenu 
or double-click the shortcut on the desktop if you’ve selected to create it during installation. License 
agreement window will appear. Read through it and click Accept.

To register Kid Pix Deluxe 3D: 

Register your copy of Kid Pix to be notified about product updates and news. You can register your 
copy of Kid Pix by choosing the Kid Pix Registration from the Help menu. 

To log in to Kid Pix Deluxe 3D: 

When you launch Kid Pix Deluxe 3D, the Login dialog appears. 

Type your name in the box labeled “1. 	  Enter a name to add to the list”. 

Click 2. 	  Go to open Kid Pix Deluxe 3D. 

From now on, your name will be in the “Kid Pix user list” box, and you can double-click it to start 
using Kid Pix. For details on adding more users, see “Setting Up Multiple Users” on page 69. 
Note: You can turn the Login dialog off using the Kid Pix Preferences dialog. For more 
information, see “Turning Off the Login Dialog” on page 69. 

Installing Kid Pix DVD Contents
If you do not want to use the DVD while working with the application, you can install all Kid Pix DVD 
contents on your hard disk.

To install Kid Pix DVD contents: 

Launch Kid Pix by clicking the 1. 	  Kid Pix 3D icon located in the Kid Pix 3D folder of the Start 
menu. 

Log in to Kid Pix using the Login dialog. 2. 	

Choose 3. 	  Install Kid Pix DVD Contents from the File menu on the menu bar. For information 
on displaying the menu bar, see “Using the Menus” on page 13.
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The Kid Pix Deluxe 3D Paint Zone
After logging in to Kid Pix Deluxe 3D, you will see the Paint Zone. For more information on using the 
Paint Zone, see “Working with Pictures” on page 51.

Library 
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Play PictureSaveCreate New Picture

Print
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Screen 
Eraser

Exit

Paper Texture 
Canister

Extended 
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Drawing Area
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Export to 
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Picture Title
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The Kid Pix Deluxe 3D Slide Show
You can make a Slide Show with your pictures. For more information on using Slide Show, see 
“Working with Slide Shows” on page 56.
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Using the Menus
Kid Pix Deluxe 3D has menus you can display and use. For a full list of all the menu commands, see 
“The Kid Pix Deluxe 3D Menus” on page 71.

To display the menus:

Position the pointer at the very top of the screen by moving your mouse.1. 	

When you see a black triangle outlined in white, make a single click. The menu bar will 2. 	
appear.

Click the desired menu title to open it, then click the command you want to choose.3. 	

Getting Help
In the Paint Zone and Slide Show, you can find out more information about items on the screen. 
There are different types of help available: Extended Help, Coaching Help, Help Tags, and the User’s 
Guide.

Extended Help
Click the 1. 	  Extended Help button.

Move the pointer over the items you want help with.2. 	

Read and listen to the help message. Wait for a few seconds to hear the message again. 3. 	
Move the pointer away and the current help message will disappear.

Click once anywhere, or tap the 4. 	  Extended Help button again if you are using a tablet 
computer, to leave Extended Help mode.

Coaching Help 
If there is no mouse or keyboard activity for a certain period of time, you will get Tips telling you 
how to use the currently selected tool. A voice reads the helpful Tips out loud. You can set the period 
of time after which Coaching Help starts. For details, see “Setting Up Kid Pix Preferences” on page 
67. 

Help Tags
You will see and hear helpful explanations when you place your pointer over any tool or button for a 
few seconds. For details on additional help tag settings, see “Setting Up Kid Pix Preferences” on page 
67.

To turn help tags off and on:

To turn help tags off, choose 1. 	  Turn Help Tags Off from the Help menu. The Control 
automatically changes to Turn Help Tags On.

To turn help tags on, choose 2. 	  Turn Help Tags On from the Help menu. The Control 
automatically changes to Turn Help Tags Off.

Kid Pix Deluxe 3D User Guide
From the 1. 	  Help menu, choose Kid Pix User Guide.

Read or print the information.2. 	
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Removing Kid Pix Deluxe 3D

To remove Kid Pix Deluxe 3D from your computer:

Click the 1. 	  Start menu.

Choose 2. 	  Uninstall Kid Pix 3D from the Kid Pix 3D folder of the All Programs submenu. 

Choose 3. 	  Yes to completely remove Kid Pix Deluxe 3D.

Uninstalling may take some time, please be patient.4. 	

Leave “Delete stored user data” checkbox deselected if you want to save your user data.5. 	

Click 6. 	  Finish.
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Using the Art Tools
In this chapter you will learn about:

Using Drawing Tool•	 s

Using Painting Tool•	 s

Using Paint Bucket Tool•	 s

Using Mixer Tool•	 s

Using Rubber Stamp Tool•	 s

Using Paper Texture•	 s

Using Color Swatch and Eye Droppe•	 r

Using Eraser Tool•	 s

Using Multi-Level Undo Gu•	 y

Using Drawing Tools
Use Kid Pix Drawing Tools to draw different kinds of lines and shapes. There are four drawing tools: 
Pencil, Chalk, Crayon, and Marker. You can draw freestyle, straight or curved lines, rectangles, 
circles, or polygons.

To draw:
Click the1. 	   Drawing Tools button.

Shape 
Outline

Circle 
Outline

Box 
Outline

Freestyle 
Line

Straight 
Line

Marker  		
(see-through)

Chalk 
(soft/fuzzy)

Pencil 
(solid)

Crayon 
(hard/fuzzy)

Line Thickness Curved 
Line

Filled 
Box

Filled 
Circle

Filled 
Shape

Pick a 2. 	  tool.

Select a thickness for the line.3. 	

Select a shape or a line type.4. 	

Click in the drawing area and, holding down the mouse button, move the mouse around to 5. 	
draw.
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For rectangles, circles, and polygons, you can draw either a filled or an outline shape. Outlines let 
the background show through.

To draw a curve, click the•	  Curved line and click in the drawing area in the place where you 
want to start drawing a curve. Holding down the mouse button, draw a straight line. Release 
the mouse button and move the pointer over the line to bend it to the curve you want, then 
click again.

To draw a polygon, click the •	 Shape outline or Filled shape. Draw the sides, clicking at the 
end of each one. Finish by clicking the starting point again.

Drawing Tips
If you change the •	 paper texture and then draw with the Crayon, Chalk, or Marker, the 
texture shows through under your drawing. For more information on using paper texture, see 
“Using Paper Textures” on page 22.

To draw vertical and horizontal lines, or squares and circles, hold the •	 Shift key while drawing.

Using Painting Tools
Use Kid Pix Painting Tools for a dazzling array of realistic and out-of-this-world painting effects. There 
are three different tools: Paint Brush, Sound Art tool, and Spray Can. Each tool has two modes.

To paint:

Click the 1. 	  Painting Tools button.

Realistic Paint Mode

Paint Brush Show Next Row

Show Previous Row

Row Number

Paint Brush Size Paint Style Options

Click 2. 	  Paint Brush, Sound Art, or Spray Can. See the next few pages for more information 
about each kind of tool.

Select a 3. 	  size (not every tool has a size selection).

Select a painting mode. When you pick a 4. 	  mode, the options change.

Select a painting option.5. 	

Click the arrows at the right side of the 6. 	  tray to see more painting options.

Click the drawing area and, holding down the mouse button, move the mouse around to 7. 	
paint.

Paint Brush
Click Paint Brush and select a brush size and painting mode. In the Realistic Paint mode you can 
paint like with a real brush.
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The Wacky Paint mode creates magical effects.

Note: Most of the Wacky Paint options change their drawing style when you press the Shift, Alt, or 
Control keys while drawing.

The Sound Art Tool
To use the Sound Art tool, you need to talk, sing, or play music into a built-in microphone or one 
attached to your computer. 

The “Mouse-move” mode lets you direct the painting with your mouse and voice.

Sound Art Tool Mouse-move Mode

The “Hands-free” mode lets the sound do the painting.

Note: If this tool does not work properly, make sure you have your microphone connected and that 
the corresponding device is selected in the Recording tab of the Sound dialog of the Hardware 
and Sound category of the Control Panel. If you are using Windows XP then go to the Control 
Panel > Sound, Speech and Audio devices > Sound and Audio devices > Audio tab.

Hands-free Mode

Wacky Paint Mode
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Spray Can
The Paint Shapes mode sprays three-dimensional shapes: balloons, bugs, candies, and so on. 

The Moving Paints mode sprays balloons, bubbles, and creatures that dance, fly, hop, or wiggle.

Painting Tips
Experiment with •	 Painting Tools, modes, and options. Try lots of different combinations.

For information on adding text in the •	 Wacky Paint mode, see “Alphabet Text Tool” on page 
26.

Some of the•	  Realistic Paint options of the Paint Brush tool let a paper texture show through.  
For more about paper texture, see “Using Paper Textures” on page 22.

Using Paint Bucket Tools
Paint Buckets let you fill up an area of your picture. There are three kinds of Paint Bucket Tools. 
Single Color Paint Bucket fills an area with one solid color or a single-color pattern. Blend of Colors 
Paint Bucket fills an area with a blend of colors. Multicolor Pattern Paint Bucket fills an area with a 
multi color pattern.

To fill an area:

Click the 1. 	  Paint Bucket Tools button to see the Paint Buckets tray. 

Pick a bucket from the left side of a tray.2. 	

Select a fill option from the right side of the tray. You can click the scrolling arrows to see 3. 	
more fill options.

Click inside the area you want to fill.4. 	

Moving Paints Mode

Paint Shapes Mode

Spray Can
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The Single Color Paint Bucket uses the current color in the Color Swatch. Select solid color or one 
of the single-color patterns.

Solid Color Fill Option

Single Color Paint Bucket

Show Previous Row

Row Number

Show Next RowSingle Color Pattern Option

The Blend of Colors Paint Bucket does not use the current color in the Color Swatch. You can pick 
any of the blends to use in your painting. 

Blend of Colors Paint Bucket

The Multicolor Pattern Paint Bucket does not use the current color in the Color Swatch. You can 
pick any of the multicolored patterns to use in your painting.

Multicolor Pattern Paint Bucket

Fill Tips
Position the pointer on your picture and click and hold the mouse button down while the blend •	
or pattern effects appear. Then, without releasing the mouse button, you can move the mouse 
around to change how the blend colors or pattern appear inside the area on your picture.

You can design your own two-color patterns. Fill an area with a solid color, then change the •	
color in the Color Swatch and fill the same area with a single-color pattern.

For information on changing the color for the Single Color Paint Bucket, see •	 “Using Color 
Swatch and Eye Dropper” on page 22.
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Using Mixer Tools
Mixers mix up your picture. You can mix up the whole painting with the Mega Mixer, or just parts of 
the picture with the Mixer Wand.

To mix things up:

Click the 1. 	  Mixer Tools button to see the Mixers tray.

Mega Mixer Mixer Wand  Mixer Effect Size Mixer Effect Preview

Show Previous Row

Row Number

Show Next Row

Pick the 2. 	  Mega Mixer or the Mixer Wand from the left side of the tray. The Mega Mixer 
mixes up the whole picture with one click; the Mixer Wand mixes the places where you drag 
it.

Select a mixer effect from the right side of the tray. You can click the scrolling arrows to see 3. 	
more effects.

Select a mixer 4. 	  effect size.

Click your picture with the 5. 	  Mega Mixer or drag the Mixer Wand to mix areas on your picture.

Mixer Tips
Mix up an imported photograph for fun results. For information on importing photos, see •	 “To 
import a background” on page 34.

The size of the •	 Mega Mixer influences the intensity of the mixer effect.

Using Rubber Stamp Tools
Use the Rubber Stamp Tools to stamp different images onto your picture.

To use Rubber Stamp Tools:

Click the1. 	   Rubber Stamp Tools button to see the Rubber Stamps tray.

   

Stamp Editor

List of Categories Size Rubber Stamp Preview

Show Previous Row

Row Number

Show Next Row



21

USER GUIDE

Using the Art Tools

Choose a category from the pop-up list. Click the arrows at the right side of the pop-up list to 2. 	
scroll through the list of stamp categories.

Select a size for your rubber stamp.3. 	

Select a rubber stamp, then click on the canvas of your picture.4. 	

Editing Rubber Stamps
You can edit rubber stamps.

To edit rubber stamps:

Click the 1. 	  Rubber Stamp Tools button to see the Rubber Stamps tray.

Click the stamp you want to edit.2. 	

Click the3. 	   Stamp Editor button to open the Stamp Editor.

Note: Alternatively, you can open the Stamp Editor by double-clicking the stamp you want 
to edit in the Rubber Stamps tray.

Pencil

Fill Bucket

Rotate

Flip Horizontal

Undo Guy

Eraser

Stamp Preview

Color Picker

Use these tools to change your stamp:

Use •	 Pencil to draw on the stamp.

Pick a color in the •	 Color Picker and use Fill Bucket to recolor the stamp.

Click •	 Rotate button to turn the stamp 90 degrees clockwise. You can do this several 
times.

Click •	 Flip Horizontal button to turn your stamp over from left to right, giving you a 
mirror image.

Click •	 Undo Guy button to undo your action, or click Restore Original button to go back 
to the original stamp view.

Use •	 Eraser to erase the whole stamp so you can start from scratch.

Click 4. 	  OK when you are finished.
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Using Paper Textures
You can change the background texture of your Kid Pix picture. Then, when you draw with the 
Crayon, Marker, Chalk, or use some of the Realistic Paint options of the Paint Brush tool, a 
pattern will show through under your drawing.

To change a Paper Texture:

Click the 1. 	  Paper Texture Canister in the bottom-right corner of the Drawing Area. The 
Paper Textures tray opens. 

Scroll through the 2. 	  paper textures in the tray.

Click the texture you want. You can see the texture you have selected on the 3. 	  Paper Texture 
Canister.

Draw with 4. 	  Crayon, Marker, Chalk, or with some of the Realistic Paint options of the Paint 
Brush tool to see the texture in your picture.

Using Color Swatch and Eye Dropper
Many Kid Pix art tools use the color you choose from the Color Picker. You can see the current color 
in the Color Swatch at the bottom-left corner of the Paint Zone and on many art tools.

The Color Picker also includes Eye Dropper, a tool that lets you pick up and use any color in your 
picture.

To pick a color in the Color Picker:

Move the pointer over the 1. 	  Color Swatch. The Color Picker pops up.

Eye Dropper

Color Picker

Click a color in the Color Picker. As soon as you pick a color, the 2. 	  Color Swatch changes 
to show your new choice. Move the pointer out of the Color Picker to lose it and continue 
working with Kid Pix.
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To pick up a color with the Eye Dropper:

Open the Color Picker by moving the pointer over the 1. 	  Color Swatch.

Click the 2. 	  Eye Dropper.

Move the 3. 	  Eye Dropper over the screen. As the pointer moves, the Color Swatch changes to 
show colors that the Eye Dropper can pick up.

Click when the color you want appears in the 4. 	  Color Swatch. The Color Picker closes. The 
color you have clicked becomes the current color for the selected tool.

Using Eraser Tools
Big Eraser erases your whole picture. You can also click the Firehose Screen Eraser to 
clear the drawing area. Mini Eraser erases the places where you drag it, leaving white space. 
You cannot erase stickers, animations, movies, or text boxes with Mini Eraser. (To remove 
these objects, select them using the Grab Hand tool in the Grab tray and press the Delete 
key.)

Note: You cannot erase foreground of the 3D background with Mini Eraser.

To erase your whole picture:

Click the 1. 	  Eraser Tools button. The Erasers tray appears.

Mini Eraser Big Eraser Mini Eraser Size Big Eraser Effect Options

Mini Eraser Shapes Show Previous Row

Show Next Row

Row Number

Click 2. 	  Big Eraser.

Pick an 3. 	  eraser effect option. You can click the scrolling arrows to see more effects.

Click your picture or double-click the eraser option.4. 	

To erase a part of your picture:

Click the 1. 	  Eraser Tools button. The Erasers tray appears.

Click2. 	   Mini Eraser.

Select a 3. 	  size for the eraser.

Pick one of these 4. 	  shapes:

To erase with a round outline, click the circle shape.•	

To erase with a square outline, click the square shape.•	

Drag the eraser in the places you want to erase.5. 	

All library objects except backgrounds can be removed from the canvas by selecting them and 
pressing the Backspace or Delete key on your keyboard.
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Using Multi-Level Undo Guy

Undo Arrow Redo Arrow

Undo Guy

Undo Guy is a universal tool for correcting your mistakes. You can undo and redo multiple 
actions in both the Paint Zone and Slide Show. Whenever you do something you don’t like, 
just click the left arrow as many times as you need to cancel the changes. If you change 
your mind and want to put the changes back, just click the right arrow. You can also click 
Undo Guy’s face once to undo your last action and click it again to redo that action.

Note: Any changes you make before saving your picture, or adding it to Slide Show using 
the Flipbook button, cannot be undone or redone.



25

USER GUIDE

Using the Text Tools

Using the Text Tools
In this chapter you will learn about:

Adding Tex•	 t

Working With Text Boxe•	 s

Changing the Way the Letters Loo•	 k

Check Spellin•	 g

Reading Text Out Lou•	 d

Teaching Kid Pix to Pronounc•	 e

Adding Text
There are three ways to add text:

Insert a text box and type text in it.•	

Use the •	 Letters Wacky Paint option to paint wacky text onto your picture.

Add 2D animations from the “Alphabet” category.•	

Adding Text Boxes
When text is in a text box, you can make your computer read it out loud.

To add a text box:

Click the 1. 	  Text Tools button. The Text tray appears.

Formatting Options Copy Read Out Loud List of Voices

Cut Paste

Click your picture where you want a text box to appear.2. 	

Start typing (tap the Keyboard button at the top of the selection frame first if you are using a 3. 	
tablet computer). The text box will grow as you fill it up.

To cut, copy, or paste text:

Select the text within the text box.1. 	

Do one of the following:2. 	

Cut:•	  To cut out the text you have selected and copy it to the Clipboard, click the Cut 
button in the Text tray.

Copy:•	  To copy the text you have selected to the Clipboard, click the Copy button in the 
Text tray.

Paste:•	  To paste the text you have cut or copied, place the I-beam pointer in the text box 
where you want your pasted text to appear and click the Paste button in the Text tray.
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Type your text in the box. (The text you type will appear in the drawing area when you use 2. 	
the Letters Wacky Paint option of the Paint Brush tool.) 

Click 3. 	  OK.

Click the 4. 	  Painting Tools button and select Paint Brush. 

Switch to the 5. 	  Wacky Paint mode and choose the Letters Wacky Paint option. 

Click the drawing area and drag the pointer over it. The text you have typed in the 6. 	  Alphabet 
Text dialog appears, following the pointer movements. 

Working with Text Boxes
You can resize a text box, move it, or delete it.

To change a text box:

Click the1. 	   Grab Tools button. 

Click the 2. 	  Grab Hand tool. The Grab tray appears.

Alphabet Text Tool 
Alphabet Text becomes a part of the background. You cannot change it after you add it to your 
picture. 

To use the Alphabet Text tool: 

Choose 1. 	  Alphabet Text from the Paint Zone menu. The Alphabet Text dialog appears. 

Grab Hand Tool Cut

Copy

Paste Previous Object

Next Object
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Click a text box to see its 3. 	  edit frame.

Scale

Scale

Scale

Scale

Do any of these things:4. 	

•	 Move: To move a text box, simply drag it. Alternatively, you can move text boxes by 
pressing arrow key or Control+arrow key on your keyboard.

•	 Resize: To change the size or shape of a text box, drag one of the Scale handles. The text 
adjusts to the new shape.

•	 Delete: To remove the selected text box, press the Delete or Backspace key on your 
keyboard, or tap the Trash Can button at the top of the selection frame if you are using a 
tablet computer.

Switch:•	  To switch between text boxes click Next Object or Previous Object buttons or 
press Tab key or Shift + Tab keys on your keyboard.

Change layers•	 : To change layer position of the object relatively to other objects, select it 
and click corresponding button - Bring to Front, Bring Forward, Send to Back or Send 
Backward.

Flatten:•	  To “flatten” text so it becomes a part of background, open the Paint Zone menu, 
click Flatten Text, and choose whether you want to flatten all your text boxes or just the 
selected one. You can also Flatten text when you are in Text Tools too.

Text Box Tips
You can •	 drag text boxes almost all the way off the page	. This lets you play text out loud with-
out having text boxes appear in the picture.

You can move and resize a text box without using the •	 Grab Hand tool. Drag the blue strip at 
the top of the box frame to move the text box, or drag the handles to resize it.

Changing the Way the Letters Look
You can change the font, font size, color, and style of your text in a text box. 

To change the look of the selected text in a text box:

Click the 1. 	  Text Tools button to see the Text tray.

In a text box, select all the text.2. 	

3. 	 Do any of these things: 

To •	 change the font, click the arrows next to the Font Name menu.

To make the text bigger or smaller, click the arrows next to the •	 Font Size menu. You 
can set almost any font size you want.

To change the •	 style, click the Bold, Italic, or Underline buttons.

To line up your text to the left, right, or •	 center, click the appropriate Text Alignment 
button.

Path Animation Loop Path
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Note: Alignment is applied to the whole text in a text box.

Use the •	 Color Picker to change the color of the text.

Checking Spelling
When Kid Pix checks spelling, it checks all the text boxes in the drawing area. You cannot check the 
spelling of rubber stamps in Small Kids Mode and alphabet text.

To check spelling:

Click the1. 	   Text Tools button. The Text tray appears.

Open the 2. 	  Edit menu.

Choose 3. 	  Check Spelling.

If Kid Pix finds a word it does not know, you can do any of these things:4. 	

To change the word, select a word from the •	 Suggestions list or type a word in the 
Change to box and click Change.

To add an unknown word to the dictionary, click •	 Learn.

To continue spell-checking without changing the word, click •	 Skip.

When you are finished, click 5. 	  Done.

Note: You can also check the spelling of a word by Control-clicking it. A shortcut menu 
appears showing you variants for the word if it has been misspelled.

Checking Spelling As You Type
This feature provides a dynamic spelling check while you are typing so that you can be sure that all 
the words you type are spelled correctly. All misspelled words will be underlined with a red dotted 
line.

To turn the Check Spelling As You Type option on:

Open the 1. 	  Edit menu.

Choose 2. 	  Check Spelling As You Type so that a checkmark appears.

Reading Text Out Loud
You can “play” a picture to hear all your text read out loud, from top to bottom and left to right. 

To hear one text box read aloud:

Click the 1. 	  Text Tools button to see the Text tray.

Select the text box you want to hear.2. 	

Click the 3. 	  Read Out Loud button in the Text tray.

To hear all text boxes read aloud:

Click the Play button.



29

USER GUIDE

Moving, Copying, Cutting, and Pasting

Changing Voice
You can use the List of Voices menu in the Text tray to change the voice that reads the text.

Note: This option is available, if your system supports another or several voices.

To change the voice that reads the text:

Click the 1. 	  Text Tools button. The Text tray appears.

Click the 2. 	  List of Voices pop-up menu and choose the voice from the list. 
Alternatively, you can pick a different voice from the list by clicking the arrows next to 
the menu.
Tip: You can adjust the way the application pronounces typed text by using different 
punctuation marks such as commas and double-dashes to make pauses of different 
lengths. This way, the text read by the application will have more realistic “intona-
tion”.

Teaching Kid Pix to Pronounce
Kid Pix might not know how to say people’s names or other special words.

To change the pronunciation:

Click the 1. 	  Text Tools button.

From the 2. 	  Paint Zone menu, choose Say It This Way. The pronunciation dialog appears.

In the 3. 	  Original Word box, type the word that Kid Pix is pronouncing incorrectly.

In the 4. 	  Pronounce As box, type the phonetic spelling of the word. For example, the letters 
“ph” sound like “f”, so the phonetic spelling of “Philip” would be “Filip”.

Click 5. 	  Original to hear the pronunciation of the original word.

Click 6. 	  Pronounce to hear the new pronunciation.

When the word sounds right, click 7. 	  Enter to apply the new pronunciation.

Click 8. 	  Done to close the dialog.
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Moving, Copying, Cutting, and Pasting
In this chapter you will learn about:

Grab Hand Too•	 l

Scissors Too•	 l

Grab Hand Tool
Use Grab Hand to pick objects up and move them, or cut, copy, and paste them.

To move objects around:

Click the 1. 	  Grab Tools button. 

Click the 2. 	  Grab Hand tool. The Grab tray appears.

Grab Hand Tool Cut

Copy

Paste

Click a sticker, 3. 	  animation, movie, or text box in your picture to select it.

Note: To switch between text boxes click Next Object or Previous Object buttons or press 
Tab key or Shift + Tab keys on your keyboard.

Do any of these things:4. 	

Move:•	  To move the object you have selected, just drag it to the place you want. You can 
also move a selected object very slightly up, down, left, or right by pressing arrow key on 
your keyboard, or move it much further using Control+arrow key.

Cut•	 : To cut the selected object (which deletes it and copies it to the Clipboard at the same 
time), click the Cut button. 

Note: If you cut a selected movie, it will not be copied to the Clipboard. The movie will 
simply be removed from the picture when you click the Cut button. 

Copy:•	  To copy the selected object to the Clipboard, click the Copy button.

Paste:•	  To paste an object into your picture (after you have cut or copied it), click the 
Paste button.

Change layers•	 : To change layer position of the object relatively to other objects, select it 
and click corresponding button - Bring to Front, Bring Forward, Send to Back or Send 
Backward.

Delete:•	  To remove the selected object, press the Delete or Backspace key on your 
keyboard, or tap the Trash Can button at the top of the selection frame if you are using a 
tablet computer.

Resize:•	  To resize the selected object you have pasted, drag its Scale handles. For more 
information, see “To move, change, or delete a sticker” on page 35.

Next Object

Previous Object
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Do any of these things:3. 	

To select an area freehand, click the •	 Free Cutout style and drag around the area you 
want.

To select a polygon area, click the •	 Polygon Cutout style and click each point of the 
polygon (at least 3 points). Click the first point again to close the shape.

To select a •	 circle or an ellipse area, click the Circle Cutout style and drag the pointer in 
any direction you want to form a circle or an ellipse.

To select a •	 square or a rectangle area, click the Square Cutout style and drag the pointer 
in any direction you want to form a square or a rectangle.

To select a cookie cutter shape area, click a •	 Cookie Cutter style, then click your picture.

Note: You can use the Shift key to select a regular circle or square area.

After selecting an area, you can drag it to the place you want cut, copy and paste it using the 4. 	
Cut, Copy and Paste buttons in the tray.

To create a sticker from an area of the background:

Select an area of the background with the 1. 	  Scissors tool.

Click the 2. 	  Make Sticker button or choose Make Sticker from the Paint Zone menu.

Note: Kid Pix will automatically switch to the Grab Hand tool.

Scissors Tool
Use the Scissors tool to cut out, move, copy, and paste a part of your background.

To cut things out:

Click the1. 	   Grab Tools button. 

Click the 2. 	  Scissors tool. The Scissors tray appears.

Cut Paste

Copy

Scissors Tool Cutout Styles

Row Number

Show Previous Row

Show Next Row

Make Sticker
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Using Libraries
In this chapter you will learn about:

Using Library Button•	 s

Backgrounds Librar•	 y

Stickers Librar•	 y

Animations Librar•	 y

Sounds & Movies Librar•	 y

Using Library Buttons
In Kid Pix libraries you can look in the trays for interesting objects to add to your picture. There are 
four oval buttons at the top-left of the screen. Each one opens a Kid Pix library.

A background in your picture is like the scenery in a play. It goes behind everything 
else you draw. See “Backgrounds Library” on page 33.

A sticker floats above your picture like a balloon at a parade. You can resize it, flip 
it, or move it to a different place. See “Stickers Library” on page 34.

Animations move around like cartoons when you “play” your picture. You can drag 
them anywhere you like. See “Animations Library” on page 36.

Each picture can have two soundtracks. Pick from a library, record your own, or 
import any available sound. See “Sounds & Movies Library” on page 41 and “Adding 
Sounds” on page 46.

You can also import movies and pictures created in other applications to your Kid 
Pix pictures. For more information, see “Adding Pictures” on page 46 and “Adding 
Movies” on page 48.

Library Trays
When you click a library button, the tray for that library appears at the bottom of the screen.

Each library contains a list of categories. For example, if you click the Animations Library button, 
you can choose the Animals category from the pop-up menu to see funny animated 3D animals.
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Note: The My Backgrounds category becomes available after you import at least one 
background to it.

Select a library collection.2. 	

Choose a category from the 3. 	  List of Categories pop-up menu.

Scroll through the backgrounds.4. 	

Add a background to your picture by double-clicking corresponding thumbnail, dragging it 5. 	
onto the canvas or selecting it and pressing Enter key on your keyboard.

List of Categories

Show Previous Row

Row Number

Show Next RowScrolling 
Arrows

Object NameObject Preview

Using the scrolling arrows on the right side of the tray, scroll through the objects until you 2. 	
find the one you want. 

Select the object you want and drag it onto the drawing area. Alternatively, you can  3. 	
double-click the selected object, or press Enter on your keyboard.

Backgrounds Library
Lots of things you draw are added to the background and become a part of it. For example, when 
you draw a line or paint a circle, that shape becomes a part of the background. When you change 
the background, those shapes disappear and the new background takes their place. If you do not 
like the result, click Undo Guy.

To add a background:

Click the 1. 	  Backgrounds Library button to open the Backgrounds tray. All backgrounds 
are divided into three collections: color backgrounds (including the 3D Scenes and My 
Backgrounds categories), line drawing backgrounds and special projects, and map 
backgrounds.

To use a Kid Pix library:

Click the 1. 	  Categories pop-up menu to see a list of categories, or use the scrolling arrows to 
scroll through the categories one by one. Click corresponding tab depending on what kind of 
categories you want to add.

Remove 
Background

Line Drawing Backgrounds and 
Special Projects

List of Categories Scrolling 
Arrows

Map Backgrounds Trash Can Background 
Preview

Background 
Name

Color 
Backgrounds

Import 
Background

Row 
Number

Show Previous Row

Show Next Row
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To remove the background from your picture:

Click the Remove Background button in the Backgrounds tray.

To import a background:

From the 1. 	  Import menu, choose Background, or click Import Background button.

Select a file format from the 2. 	  Files of type pop-up menu if you want to view files of a specific 
type only. The following formats are available: BMP, GIF, PNG, JPEG, and TIFF.

Locate and select the picture you want to import.3. 	

Choose one of these options:4. 	

•	 Shrink/stretch to fill canvas stretches or shrinks the picture to fill the whole drawing 
area.

•	 Fill canvas without shrinking/stretching puts the picture on the canvas so that it fills 
as much of the drawing area as possible without shrinking or stretching the picture out of 
shape. The edges of the drawing area might be left white.

•	 Center at original size puts the picture down the way it is, without stretching or 
shrinking it.

•	 Repeat many times scales the picture down to 25% of its original size and puts down 
lots of these smaller versions until the drawing area is filled.

To add your background to the 5. 	  My Backgrounds category, click the checkbox labeled “Add 
to My Backgrounds library when importing” so that a checkmark appears.

Click 6. 	  Import to import the picture as your new background.

Note: If you choose to add a picture to the My Backgrounds category while importing, and 
the Backgrounds Library was open before you performed the import, the My Backgrounds 
category will automatically be chosen in the pop-up menu and the imported background will 
be selected in the tray. 

To remove a background from the My Backgrounds category:

Choose the 1. 	  My Backgrounds category from the List of Categories pop-up menu.

Select the background you want to delete.2. 	

Click the 3. 	  Trash Can button.

Stickers Library
Stickers are pictures you “stick” onto your picture. Stickers do not become a part of the background 
unless you flatten them.
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Do any of these things:2. 	

•	 Move: To move the sticker, simply drag it to the place you want. Alternatively, you can 
move stickers by pressing arrow key or Control+arrow key on your keyboard.

Resize:•	  To resize a sticker, drag one of the Scale handles. To resize it proportionally, 
hold the Shift key while dragging.

Flip:•	  To flip the sticker vertically, click the left button located at the bottom center of the 
selection frame.

Flip:•	  To flip the sticker horizontally, click the right button located at the bottom center of 
the selection frame.

Flatten: •	 To make the sticker part of the background, choose Flatten Stickers & 
Animations from the Paint Zone menu. You can choose to flatten just the selected 
sticker or all stickers and animations.
Draw a path:•	  To draw an animation path for the sticker to move along, click the Path 
Animation Tool button. See “Path Animation Tool” on page 37.

•	 Delete: To remove the selected sticker, press the Delete or Backspace key on your 
keyboard, or tap the Trash Can button at the top of the selection frame if you are 
using a tablet computer. When you delete a sticker, you will see it disappears in a puff of 
smoke, like magic.

Object Stickers Flag Stickers

List of Categories Scrolling Arrows Sticker Preview Sticker Name

Show Previous Row

Show Next Row

Row Number

To add a sticker:

Click the 1. 	  Stickers Library button to open the Stickers tray. All stickers are divided 
into two collections: objects and flags.

Scale Scale

Path Animation Loop Path

Flip HorizontalFlip Vertical

Scale Scale

Select a collection.2. 	
Choose a category from the 3. 	  List of Categories pop-up menu.
Scroll through the stickers.4. 	

Add a sticker to your picture.5. 	

To move, change, or delete a sticker:

Click a 1. 	  sticker in your picture to select it.
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To create your own sticker:

Add any object you want to the canvas or select an area of the background with the 1. 	  Scissors 
tool.

Choose 2. 	  Make Sticker from the Paint Zone menu.

Note: The sticker will appear on top of the object you used to create it. If you used a movie 
or an animation or cut out a part of the background with the Scissors tool, Kid Pix will 
automatically switch to the Grab Hand tool.

Animations Library
Animations come to life when you play them. 

To add an animation:

Click the 1. 	  Animations Library button to open the Animations tray.

Scale Scale

Path Animation Loop Path

PlayOne Frame Backward One Frame Forward

Scale Scale

List of Categories Scrolling Arrows Animation Preview Animation Name

2D Animations3D Animations Show Previous Row

Show Next Row

Row Number

Click 2D or 3D tab depending on what kind of animation you want to add.2. 	

Choose a category from the 3. 	  List of Categories pop-up menu.

Scroll through the animations.4. 	

Add an animation to your picture. The animation plays automatically when you add it 5. 	
to the canvas. You can play all the animations in a picture by clicking the Play button 
located at the top-right corner of the screen.

To move, change, or delete an animation:

Click an animation on your picture to select it. 
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Do any of these things:

Move: •	 To move the animation, drag it to the place you want. Alternatively, you can move 
animations by pressing arrow key or Control+arrow key on your keyboard.

Resize:•	  To resize the animation, drag one of the Scale handles. To resize it proportionally, 
hold the Shift key while dragging.

Flip:•	  To flip an animation horizontally and/or vertically, click the Flip Vertical or Flip 
Horizontal buttons.

Flatten:•	  To make an animation part of the background, choose Flatten Stickers & 
Animations from the Paint Zone menu. You can choose to flatten only the selected 
animation or all animations and stickers.

Draw a path:•	  To make an animation move the way you want it to, click the Path 
Animation Tool button. See “Path Animation Tool” on page 37.

Delete:•	  To delete an animation, press the Delete or Backspace key on your keyboard, 
or tap the Trash Can button at the top of the selection frame if you are using a tablet 
computer. When you delete an animation, you will see it disappears in a puff of smoke, like 
magic.

Playing Animations
You can play animations in a loop or frame-by-frame.

To play an animation in a loop:

Click the animation to select it.1. 	

Click the 2. 	  Play button. It changes to the Pause button.

To pause the animation, click the 3. 	  Pause button. It changes back to the Play button.

To play an animation frame-by-frame:

Click an animation to select it.1. 	

Click the 2. 	  One Frame Forward button. Each click advances the animation one frame forward.

Click the 3. 	  One Frame Backward button. Each click advances the animation one frame back.

Path Animation Tool
Kid Pix Deluxe 3D allows you to create path animations for stickers and animation objects on the 
canvas. You can draw looped paths that start and end in the same place to make your objects 
move in circles, or point-to-point paths that take objects from one place to another — all following 
whatever route you choose.

 To create an animation path:
Click the 1. 	  Path Animation Tool button, to enter Path Animation Mode.
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Tip: The speed at which you drag the object over the canvas will determine how fast it 
moves when you play the animation.

Release the mouse button to finish the path. The 3. 	  Path Animation Mode automatically turns 
off.

If you want to leave Path Animation Mode without creating a path, click anywhere on the canvas. 
If you want to delete a path, click the Path Animation Tool button and then press the Delete or 
Backspace key on your keyboard.

Playing Animation in a Loop
By clicking the Loop button, you can keep your objects continually in motion.

Usually when you play a path animation, your object will stop when it reaches the end of the path. 
But after you click the Loop button, the object will repeat the path again and again — it will go 
back and forth along a point-to-point path, turning around at each end, or round in circles if the 
path is looped.

Position the pointer over the object, hold down the mouse button, and drag it to draw the 2. 	
path you want. The animation path is shown as you drag the object over the canvas. 

Looped PathLoop Button
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3D Background 
Category

Creating Your Own Stories
You can create single pictures that tell whole stories by using the full potential of path animation and 
the 3D backgrounds, which allow objects to be placed between the foreground and background. 

To create an animated story:

First of all drag a 3D background from the 1. 	  Backgrounds tray onto the canvas.

Animations 
Category

Select an animation from the 2. 	  Animations tray and drag it onto the canvas.

Drag the animation around the background to find places where you can hide it. Once you 3. 	
have found a good hiding place, place your animation there.

Tip: Some of the 3D backgrounds have hiding places with transparent parts that characters 
can “peep” through. 
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Click the 4. 	  Path Animation Tool button and drag your animation to draw. To make your 
character “leave” the picture, just drag it away from the drawing area. The speed at which 
your animation will move depends on how fast you drag it when drawing the path.

Tip: To make a character stay hidden for a while and then “pop out” to surprise everybody, 
hide it behind a foreground element and draw lots of small circles when you start creating the 
animation path. After that, quickly drag it away from its hiding place and draw the rest of the 
path on the visible part of the canvas.

When you have finished drawing a path for one animation, you can add another to create 5. 	
even more fun and action-packed stories. 

Tip: If you add a lot of objects, they will be placed on different layers, with the last one you 
added in the front. To select an object that is behind other objects, you can move the ones in 
front out of the way and click the object you need. You can also switch to it by opening the 
Grab Hand tray and clicking the Next Object or Previous Object button or by pressing 
the Tab or Shift + Tab keys on your keyboard. To bring an object to the front, click Bring 
Object to Front button or cut it by pressing Control + X and paste it by pressing 		
Control + V. Make sure you move your object back to its correct position after pasting it. 
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Choose a category from the2. 	   List of Categories pop-up menu.

Scroll through the sounds.3. 	

Click a sound preview thumbnail to hear the sound. The sound keeps playing until you 4. 	
click somewhere else on the screen.

When you have found the sound you want to add, drag its preview thumbnail to the 5. 	
canvas. Alternatively, you can double-click the thumbnail or press Enter key on your 
keyboard to add the sound. The sound starts playing automatically.

To remove the sound from your picture:

Click the Remove Sound button in the Sounds tray.

To record a sound:

Click the 1. 	  Sounds & Movies Library button to open the Sounds tray.

In the 2. 	  Sounds tray, click the Open Sound Recording Tray button. The button changes to 
the Close Sound Recording Tray button, which you can click to return to the Sounds tray.

Sounds & Movies Library
You can add sounds and movies from the Kid Pix Sounds & Movies Library, import a sound or movie 
you have on your computer, or record your own. 

Sounds tray

The Sounds tray allows you to add and import sounds to your picture, and also to record your own 
sounds.

To add a sound from the library:

Click the 1. 	  Sounds & Movies Library button to open the Sounds & Movies library.

Show Previous Row

Show Next Row

Row Number

List of Categories Remove Sound

Trash Can

Import Sound Sound Name

Open Sound 
Recording Tray

Sound Preview

Recording Time Left

Record Stop Play

Save

Close Sound Recording 
Tray
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In the 3. 	  Sound Recording tray, click the Record button to start recording.

Click the •	 Stop button to stop recording.

Click the •	 Play button to hear the recorded sound.

When you are happy with the recorded sound, click the 4. 	  Save button.

Give your sound a name so you can find it again in the 5. 	  My Sounds category and click OK.

The Sound Recording Tray automatically closes and the My Sounds category opens for you to add 
your new sound to the picture.

To import a sound:

Choose 1. 	  Sound from the Import menu or click Import Sound button in the Sounds tray. 

Find the sound file you want to import and click it. With 2. 	  Kid Pix Deluxe 3D, you can now 
import sound files in the following sound formats: WAV, MP3, AIFF, and AAC.

To add your sound to the 3. 	  My Sounds category, click the checkbox labeled “Add to My 
Sounds library when importing” so that a checkmark appears.

Click 4. 	  Import to add the sound to the picture.

Note: If you choose to add your sound to the My Sounds category when importing it, and 
the Sounds tray was open before you performed the import, the My Sounds category will 
automatically be chosen in the List of Categories pop-up menu and the imported sound will 
be selected in the tray.

Double soundtrack

Kid Pix Deluxe 3D allows you to add two soundtracks to your picture — one from the built-in Sounds 
library and another from the My Sounds category. The soundtrack from the built-in Sounds library 
will play at a lower volume than your own soundtrack. By using two soundtracks you can do things 
like narrating the story in your picture while music plays in the background.

To make a double soundtrack for your project:

Go to the 1. 	  Sounds & Movies Library and select a sound that suits your picture.

Drag the sound to your picture or double-click it. The sound will be added and will start 2. 	
playing.

If you want to add a soundtrack you recorded earlier, proceed to step 3. 	  6. If you want to record 
your own soundtrack, click the Open Sound Recording Tray button in the Sounds tray. 
The Sound Recording tray appears. 

Click the 4. 	  Record button and record your soundtrack. Click the Stop button to stop recording.

Tip: When recording, you can tell the story happening in your picture, give your characters 
voices, make sound effects, play an instrument or do whatever else you like.

Click the 5. 	  Save button to save your soundtrack. Give it a name so you can find it again in the 
My Sounds category, and then click OK.
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Choose the 6. 	  My Sounds category from the List of Categories pop-up menu. Select your 
sound and add it to the picture.

Now your picture has two soundtracks! 7. 	

To remove a sound from the My Sounds category:

Choose the 1. 	  My Sounds category from the List of Categories pop-up menu.

Select the sound you want to delete.2. 	

Click the 3. 	  Trash Can button.

Movies tray

The Movies tray allows you to add and import movies to your picture, record your own, and even 
put them into fun-looking frames.

Adding movies to your picture 

Choose from over a hundred movies in the Kid Pix galleries. You can add a movie to your picture as 
a video background, or you can add one when you have already placed a 3D background — this way 
the movie will be placed between the foreground and background layers.

To add a movie to your picture:

Click the 1. 	  Movies tab in the Sounds & Movies tray.

Choose a category from the2. 	   List of Categories pop-up menu.

Scroll through the movies thumbnails.3. 	

Add the movie you want by dragging its thumbnail to the canvas. Alternatively, you can 4. 	
double-click the thumbnail or press Enter key on your keyboard to add the movie. The movie 
starts playing automatically.

Tip: To make the movie fill the canvas and use it as the background, click the Enlarge to 
Fill Canvas button in the Movies tray or choose it from the Edit menu or press Control + L 
on your keyboard. The movie will be sent to the back layer.

List of 
Categories

Video Narration Show Previous Row

Show Next Row

Row 
Number

Video Frame

Import Movie File

Enlarge to Fill Canvas

Movie Preview

Movie Name
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Video narration

Kid Pix Deluxe 3D allows you to record your own movies. You must have a camera built-in or 
connected to your PC, otherwise the recording option will be unavailable. 

To record your own movie:

Click the 1. 	  Sounds & Movies Library button and then click the Movies tab to see Movies 
tray.

In the 2. 	  Movies tray, click the Video Narration button or choose Video Narration from the 
Import menu. The Record Video dialog appears.

Record Play

Choose a video and audio source for recording from the corresponding pop-up menus. Leave 3. 	
the “Show costume frame guideline” option selected to see which part of the video you 
are recording will be visible under the costume frame.

Note: If your computer doesn’t have a microphone, the Audio Source pop-up menu will be 
dimmed. 

Click the 4. 	  Record button. After a three-second countdown, recording begins. To stop 
recording, click the Record button again. To play your movie, click the Play button.

To add your recorded movie to your picture, click 5. 	  Add to Picture button. 
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Importing movies to your picture

Kid Pix Deluxe 3D allows you to import movies from your hard disk. 

To import a movie from your hard disk:

Click the 1. 	  Import Movie File button. The Import Movie dialog appears.

Find the movie you want to import and click it.2. 	

Click 3. 	  Import to add the movie.

To create a sticker from a movie or animation:

Add a movie or animation to the canvas.1. 	

Play the movie or animation and pause it on any frame that you want to use as a sticker.2. 	

Choose 3. 	  Make Sticker from the Paint Zone menu.

Note: Kid Pix will automatically switch to the Grab Hand tool.

Adding a frame to your movie

You can add a frame to your movie. Kid Pix has a variety of frames to choose from.

To add a frame to a movie:

Click the 1. 	  Video Frame button. The Video Frames dialog appears.

Scroll through the thumbnails and select the frame you want.2. 	

Click the 3. 	  Add button.
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Adding Stuff to Your Picture
In this chapter you will learn about:

Adding Picture•	 s

Adding Sound•	 s

Adding Movie•	 s

Adding Pictures
Photographs and pictures you create with other applications can become stickers on your Kid Pix 
picture. You can flatten them and even paint on them and add special effects.

To add a picture:

From the 1. 	  Import menu, choose Graphic.

Find the picture you want to add and click it. Choose 2. 	  BMP, JPEG, GIF, TIFF, or PNG format 
from the Files of type pop-up menu if you want to view a specified file type.

Select one of these options:3. 	

•	 Shrink/stretch to fill canvas stretches or shrinks the picture to fill the whole drawing 
area.

•	 Fill canvas without shrinking/stretching puts the picture on the canvas so that it fills 
as much of the drawing area as possible without shrinking or stretching the picture out of 
shape. The edges of the drawing area might be left unfilled.

•	 Center at original size puts the picture down as it is, without stretching or shrinking it.

•	 Repeat many times scales the picture down to 25% of its original size and puts down 
lots of these smaller versions until the drawing area is filled.

Click 4. 	  Import to add the graphic to the picture.

You can use the handles of the graphic to change its size.5. 	

Picture Tips
To add a graphic to the picture as a background, see "To import a background" on page 34.

Adding Sounds

To import a sound:

From the 1. 	  Import menu, choose Sound.

Find the sound file you want to import and click it.2. 	

With Kid Pix Deluxe 3D you can import the following sound formats: WAV, AIFF, MP3, and 
AAC. 

Tip: To add your sound to the My Sounds category, click the checkbox labeled “Add to My 
Sounds library when importing” so that a checkmark appears. For information on using 
the Sounds Library, see “Sounds & Movies Library” on page 41.

Click 3. 	  Import to add the sound to your picture.
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Importing Sounds from iTunes
You can browse through your iTunes playlists directly from Kid Pix and attach your favorite sounds 
to your picture. Audio tracks cannot be imported directly from an audio CD. You should first import 
them to iTunes.

To import sounds from iTunes:

From the 1. 	  Import menu, choose From iTunes.

The2. 	   Import From iTunes dialog appears. You can sort your songs by artist, album, song 
name, and time. 

To import your song or song fragment, click the 7. 	  Import button. The imported song 
or song fragment is added to the currently open Kid Pix picture. 

Click the 8. 	  Play button to hear the sound you have imported.

Note: If you have moved, renamed, or deleted the iTunes library file that was stored in the 
default location, you cannot import any sounds from your iTunes playlists unless you restore 
the library file to this location.

To listen to the track you have selected before importing it, click the 3. 	  Test button. To listen to 
it playing in a loop, click the “Loop music” checkbox so that a checkmark appears.

Select one of the radio buttons in the 4. 	  Import group. Click the first option to import the entire 
song. Click the second option to import just a fragment, the duration of which can be chosen 
from the pop-up menu. The preset duration of an imported fragment is 5 seconds.

If you have chosen to import just a fragment of a song, you can select the checkbox labeled 5. 	
“Fade out at end of selection”. This means the fragment you import will not end abruptly, 
but fade out gradually when it is played.

To add your song or song fragment to the 6. 	  My Sounds category, click to select the checkbox 
labeled “Add to My Sounds library when importing”. Once imported, this song can 
be accessed in the My Sounds category. For information on using the Sounds & Movies 
Library, see “Sounds & Movies Library” on page 41.



48

USER GUIDE

Adding Stuff to Your Picture

Adding Movies
You can add QuickTime® movies (.MOV) to a Kid Pix picture.

To import a movie:

From the 1. 	  Import menu, choose Movie File.

Find the movie you want to import and click it.2. 	

Click 3. 	  Import to add the movie.

To move, change, or delete a movie:

Click the 1. 	  Grab Tools button. The Grab tray appears.

Click 2. 	  Grab Hand.

Do any of these things:3. 	

Move:•	  To move a movie, select it and drag it to where you want it to be. Alternatively, you 
can move a movie by pressing arrow key or Control+ arrow key on your keyboard.

Resize: •	 To resize a movie, select it and drag one of the Scale handles on its frame. To 
resize it proportionally, hold the Shift key while dragging.

Delete:•	  To delete a movie, select it and press the Backspace or Delete key on your 
keyboard, or tap the Trash Can button at the top of the selection frame if you are using a 
tablet computer.

Flatten:•	  To make a movie part of the background, select it and then choose Flatten 
Movies from the Paint Zone menu. You can choose to flatten only the selected movie or 
all movies.

Playing Movies
You can play movies in a loop or frame-by-frame. Movies are also played when you play your whole 
picture.

To play a movie in a loop:

Click the movie to select it.1. 	

Click the 2. 	  Play button. It changes to the Pause button.

To pause the movie, click the 3. 	  Pause button. It changes back to the Play button.

To play a movie frame-by-frame:

Click the movie to select it.1. 	

Click the 2. 	  One Frame Forward button. Each click advances the movie one frame forward.

Click the 3. 	  One Frame Backward button. Each click advances the movie one frame back.

Movie Tips
To export Kid Pix pictures as QuickTime movies, see •	 “Exporting Your Picture” on page 53. To 
export Slide Shows as QuickTime movies, see “Exporting Your Slide Show” on page 65. 

When you print your picture, the movie frame you see is the one that will be printed. You can •	
play the movie frame-by-frame and stop it when it looks the way you want it to be printed.

To make a movie part of the background, choose •	 Flatten Movies from the Paint Zone 
menu. You can choose to flatten only the selected movie or all movies.
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Publish to YouTube
You can share the movies you make in Kid Pix with the whole world. Please note that you must have 
a YouTube or Google™ account and your PC must be connected to the Internet to use this feature.

Note: To be able to publish your video, it must contain animation, movie, video background or path 
animation.

To publish your movie to YouTube:

Choose 1. 	  YouTube from the Share menu. The Publish to YouTube dialog appears.

Enter your YouTube or Google username and password, and then click the 2. 	  Sign In button. 

Choose a category and add a title, description and search tags for your movie. Otherwise you 3. 	
won’t be able to publish to YouTube.

Select the “4. 	  Make this movie personal” option if you want to limit access to your movie on 
YouTube.

Select the “5. 	  Include 3D stereographic effect” option if you want the 3D effect to be applied 
to the movie. 

Click 6. 	  Next. 
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The 7. 	  YouTube Terms of Service appear. Read through them and click the Share button to 
publish your movie. Publishing may take some time, please be patient.

A link to your movie will appear. Click the 8. 	  View button to watch your movie on              
www.youtube.com, or click OK to go back to the Paint Zone or Slide Show, depending on 
where you were before. 

http://www.youtube.com/
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Working with Pictures
In this chapter you will learn about:

Starting Your New Picture•	

Saving Your Picture•	

Saving Your Picture As a Templat•	 e

Opening Your Pictur•	 e

Playing Your Pictur•	 e

Printing Your Pictur•	 e

Exporting Your Pictur•	 e

Exporting Pictures with 3D Effect•	 s

Watching Your Movie on an Apple•	 ® Device 

Starting Your New Picture
You can start with a blank page or use the Idea Machine like an electronic coloring book.

To start with a blank page:

Click the Create New Picture button.

Note: If you have not saved changes made to the picture that is already open, Kid Pix asks if 
you want to save them before creating a new one.

To use the Idea Machine:

From the 1. 	  File menu, choose Idea Machine.

Note: If you have not saved changes made to the picture that is already open, Kid Pix asks if 
you want to save them before opening an Idea Machine picture.

In the 2. 	  Idea Machine dialog that appears, select the picture template you want to use.

Click 3. 	  Open.

Saving Your Picture
By default, Kid Pix saves your pictures in the My Pictures folder so they are easy to find and open 
again. The My Pictures folder is located in the current Kid Pix user folder that is stored in the Kid 
Pix Users folder within the Documents folder of the current system user.

To save a new picture:

Click the 1. 	  Save button or double click the picture title. The Save Picture As dialog appears.

Type a 2. 	  name and select a location for your picture.

Click 3. 	  Save. If you already have a picture with the same name, Kid Pix asks whether you want 
to replace the old picture with the new one.
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To save changes to a picture:

Click the Save button.

Note: If you want to leave the original picture without changes, choose the Save As command from 
the File menu and save the picture with the changes you have made as a new picture.

Saving Your Picture As a Template 
You can save your picture as a template so that it remains unchanged and you can create several 
versions of your picture based on the template. You can also add your template to the Idea 
Machine. This way you can easily access your template pictures by choosing Idea Machine from 
the File menu. 

To save a picture as template: 

Choose 1. 	  Save as Template from the File menu. 

Type a name and select a location for your picture.2. 	

If you want to add your picture to the Idea Machine, select the 3. 	  “Also add to the Idea 
Machine” checkbox.

Note: Administrator privileges are required to add templates to the Idea Machine. 

Click 4. 	  Save. 

Note: If you already have a template with the same name, Kid Pix asks whether you want to 
replace the old template with the new one.

Opening Your Picture
You can open any picture you have created and saved.

To open a picture you saved earlier:

Open the 1. 	  File menu.

Choose 2. 	  Open.

Note: If you have not saved changes made to the picture that is already open, Kid Pix asks if 
you want to save them before opening a new picture.

In the3. 	   Open Picture dialog that appears next, click the picture you want to open.

Click 4. 	  Open.

Playing Your Picture
If your picture contains animations, stickers with path animation applied, movies, or sounds, you can 
see them play over and over when you play your picture.

To play your picture:

Click the 1. 	  Play button. It changes to the Stop button.

Click the 2. 	  Stop button to stop playing the picture. It changes back to the Play button.

Note: All animations will be played synchronously.
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Printing Your Picture
You can print a Kid Pix picture in a regular size or as a poster.

Kid Pix prints the frames of movies and animations that are shown at the moment that you print.

 To print your picture:

Click the 1. 	  Print button. The Print dialog appears.

Select one of the following options:2. 	

•	 Full page prints a picture on one separate page.

Poster 2x2 pages•	  prints your picture on four sheets of paper.

Poster 3x3 pages•	  prints your picture on nine sheets of paper.

When you print your picture as a poster, Kid Pix prints parts of it on separate sheets of 
paper. You can then tape the sheets of paper together to make the poster.

If you want to customize your printing settings, click 3. 	  Preferences button, make all necessary 
adjustments and click OK.

Click 4. 	  Print to print the picture.

Exporting Your Picture
You can export your Kid Pix picture to another file format to open it without Kid Pix. For example, if 
you save your Kid Pix picture in JPEG format, you can add it to a web page. Kid Pix Deluxe 3D can 
now export in the following graphic formats: BMP, JPEG, TIFF, PNG, and PICT. Everything in the 
picture is flattened. To retain animation, movies, or sounds in your picture, export it as a QuickTime 
movie.

To export your picture:

Open the 1. 	  File menu.

Choose 2. 	  Export. Export Picture As dialog appears.

Navigate to where you want to save your exported picture.3. 	

Type a name for the exported picture.4. 	
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Choose an export format from the 5. 	  Save as type pop-up menu located at the bottom of the 
dialog: 

BMP, JPEG, TIFF, PNG, or •	 PICT. 

•	 QuickTime Movie: The exported file can be played on any kind of computer with 
QuickTime Player installed. To download the player, go to www.apple.com.

Click 6. 	  Save.

Note: If you select “Reduce the movie size”, your movie will be compressed so it can be 
viewed on your iPod nano® or iPod classic®. If you select “Add to iTunes Library when 
exporting”, your movie will be added automatically to your iTunes library.

Exporting Pictures with 3D Effects
Kid Pix Deluxe 3D comes with an amazing 3D stereographic effect. This allows you to view three-
dimensional pictures, movies, and Slide Shows while wearing the special red-blue 3D glasses that 
are included with the product. Many of the Kid Pix graphics are in full 3D, and you can place your 
objects “inside” the layers of the rich 3D background pictures. 

Note: Pictures, movies, and Slide Shows have the 3D effect applied only when they are exported. 

To export a picture in 3D:

Click the 1. 	  Export to 3D button. The Export Picture As dialog appears.

Type a name and select a location for your picture.2. 	

Choose a file format from3. 	   Save as type pop-up menu.

Make sure that “4. 	  Include 3D stereographic effect” option is selected and click Save.

After you have exported your project, open it in an appropriate viewer application and put on pair of 
the red-blue 3D glasses. While looking at your 3D picture, movie, or Slide Show move and tilt your 
head to look at the screen from different angles. This way you’ll experience the full amazing effect of 
the 3D graphics.

http://www.apple.com/
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Watching your movie on an Apple device 

Kid Pix Deluxe 3D allows you to export your movies to your portable Apple devices. You can view  
your movies on iPad®, iPhone®, iPod nano®, iPod classic®, and iPod touch®. 

To view your movie on your portable device: 

Export your movie to your hard disk with the 1. 	  “Add to iTunes Library when exporting” 
option selected. For more information, see “Exporting Pictures with 3D Effects” on page 54 
and “Exporting Your Slide Show” on page 65. 

Note: The “Reduce the movie size” option must be selected if you are planning to watch 
the movie on your iPod nano or iPod classic. For iPad, iPod touch or iPhone it must be 
exported without reducing the movie size. 

Launch iTunes2. 	  ®. 

Connect your device to the computer. 3. 	

Select your movie. If you are going to view the movie on iPod nano or iPod classic, proceed to 4. 	
step 6. 

Choose 5. 	  Create iPod® or iPhone Version or Create iPad or Apple TV Version from the 
Advanced menu, depending on the device you want to use to view your movie. 

Drag the resulting movie from “Kid Pix Videos” playlist to your device. 6. 	
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Working with Slide Shows
In this chapter you will learn about:

Creating and Opening Slide Show•	 s

Loading Picture•	 s

Editing Picture•	 s

Moving Pictures Aroun•	 d

Customizing Your Slide Sho•	 w

Playing Your Slide Sho•	 w

Printing Your Slide Sho•	 w

Saving Your Slide Sho•	 w

Exporting Your Slide Sho•	 w

Creating Animations from Your Slide Sho•	 w

Creating and Opening Slide Shows
You can make a Slide Show with your pictures. Load pictures into your Slide Show and put them in 
any order you like. Add transition, audio, and page advance options. Then save, play, print, or export 
your Slide Show.

Going to Slide Show
You can go back and forth between the Paint Zone and Slide Show.

To go to Slide Show:

Click the Go to Slide Show button in the bottom-right corner of the Paint Zone, or choose Go 
to Slide Show from the Go menu.

Starting Your Slide Show
You can create a brand new Slide Show or open an existing one.

To create a new Slide Show:

Click the 1. 	  Create New Slide Show button at the bottom-left corner of the screen.

Load pictures into the slides. For details, see 2. 	  “Loading Pictures” on page 57.

Click the 3. 	  Save Slide Show button or double click the slide show title and type a name for 
your Slide Show in the Save Slide Show As dialog.

The name of your Slide Show appears at the top of the screen and a saved Slide Show icon 
appears in the Saved Slide Shows tray.
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Click the2. 	   Load Picture icon.

In the 3. 	  Load Picture dialog that appears, navigate to the place where your pictures are 
stored and select the one you want (by default they are stored in the My Pictures folder).

Click 4. 	  Load.

Repeat these steps for as many slides as you need.5. 	

To load a slide directly from the Paint Zone:

Click the Flipbook button or press Shift + Control + A. Your picture — exactly the way it 
looks now — will be added to the end of your Slide Show. If you don’t have a Slide Show 
open, Kid Pix will create a new one with your picture as the first slide. The last number on the 
Flipbook button shows how many slides there are in the current Slide Show, and the first 
one — the number of the current slide if you are editing it. 

Editing Pictures
To change a picture that you want to load or to create a new picture, go back to the Paint Zone. 	If 
you want to change a picture that is already in a slide, double-click it and it will open in the 	
Paint Zone for you to make your changes. To apply changes, save the slide. It will be updated in your 	
Slide Show.

To go back to the Paint Zone:

Click the Go to Paint Zone button in the bottom-right corner of the screen, or choose Go to 
Paint Zone from the Go menu.

To open your Slide Show:

Click the icon for the Slide Show you want in the Saved Slide Shows tray at the bottom of the 
screen.

The Saved Slide Shows tray shows only those Slide Shows which were saved by the current Kid Pix 
user. To open other Slide Shows, choose Open from the File menu.

Loading Pictures
Each slide in the Slide Show can contain a Kid Pix picture. Once you load the pictures, you can move 
them into any order you like. If you leave blank slides, Kid Pix will skip them when you play your 
Slide Show.

To load a picture:

Click the slide you want to load the picture into. The 1. 	  Load Picture icon appears at the 
bottom.
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Moving Pictures Around
Slide Show plays slides in the order they appear on the screen. (The slides are numbered so you can 
tell the order.) You can move slides into any order you want.

To move a slide by dragging:

Drag the slide you want to move to the new location. When you drag a slide, you see an insertion 
line that shows exactly where the picture will be placed.

To move a slide by pasting:

Click the slide you want to move.1. 	

Open the 2. 	  Edit menu and choose Cut or Copy.

•	 Cut removes a picture from the slide and puts it on the Clipboard so you can paste it 
somewhere else.

•	 Copy keeps a picture where it is and puts a copy of it on the Clipboard so you can paste it 
somewhere else.

Click a new slide that you want to paste the copied or cut picture into.3. 	

Open the 4. 	  Edit menu and choose Paste.

If you paste a picture into a slide that already has a picture, the new picture replaces the old 
one.

To delete a slide from your Slide Show:

Select the slide you want to delete, and click the Trash Can or press the Delete or 
Backspace key on your keyboard. You can also delete slide by dragging it to the Trash 
Can.

Seeing All the Slides
Use the arrows at the top and bottom of the slides area to scroll through your Slide Show.

Use the arrow keys on your keyboard to move between slideholders one step in any direction, 	
or use the following keyboard shortcuts:

Alt + Up Arrow•	  to go to the first slideholder.

Alt + Down Arrow •	 to go to the last slideholder.

Alt + Left Arrow•	  to go to the leftmost slideholder.

Alt + Right Arrow•	  to go to the rightmost slideholder.

Deleting Blank Slides
You can “clean up” your Slide Show so that the blank slides do not interrupt the ones with pictures.

To delete blank slides:

Choose Delete Blank Slides from the Slide Show menu.
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Customizing Your Slide Show
You can set page advance options and add visual transition and sound effects to give your Slide 
Show a really exciting, unique appearance. For more information about transition effects, see 
“Transition Effects” on page 60. For information on attaching sounds to your Slide Shows, see “Audio 
Options” on page 61.

Page Advance Options
Page advance options tell Slide Show when to go from one slide to the next. You can have a  
different page advance option for each slide. You can tell Slide Show to display the next slide after a 
certain number of seconds, or to wait until the text of the slide is read aloud, or until you click with 
the mouse or press a key on the keyboard, or until music or sound ends. If you do not set any page 
advance option, each slide will be shown for the time you have specified in Kid Pix Preferences. For 
more information, see “Setting Up Kid Pix Preferences” on page 67.

To set up page advance options:

Click the 1. 	  Edit Transitions switch. The customizing option buttons appear on each 
slide.

Transition Effect 
Options

Page Advance Options

Audio Options

Click the 2. 	  Page Advance Options button on the slide whose options you want to change.	
The Advance to Next Slide dialog appears.

Select one of these options:3. 	

After [Number] Seconds•	  lets you enter the number of seconds to wait between this slide 
and the next one. Choose this option if you are planning to export your Slide Show later as 
a movie. See “Exporting Your Slide Show” on page 65. 
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On •	 Mouse Click tells Slide Show to wait until you click with the mouse before the next 
slide is displayed. A double-click will stop the Slide Show playing.

•	 On Pressing Any Key tells Slide Show to wait until you press any key on your keyboard 
(except Escape) before the next slide is displayed. The Escape key stops the Slide Show.

•	 When Text Reading Finishes tells Slide Show to read text in the picture and then display 
the next slide.

•	 When Narration Ends tells Slide Show to play all of the recorded narration (sound or 
video) in the picture and then display the next slide.

Note: Choose Apply to all slides in this slide show to make changes to all loaded slides of 
the current Slide Show.

Click 4. 	  OK.

Note: When Text Reading Finishes and When Narration Ends options effects will be 
active only when Play Sound and Play Text options are checked in Audio Options dialog. 
For details, see “Audio Options” on page 61.

Transition Effects
You can set up special effects between slides. These include Fade, Windmill, Wipe, Iris, and many 
more. Each effect has a sound associated with it. You can change the sound for any effect.

To set up transition effects:

Click the 1. 	  Edit Transitions switch. Options buttons appear on each slide. 

Transition Effect 
Options

Page Advance Options

Audio Options
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Select a visual transition effect in the upper scroll list.3. 	

If you do not want to have any transition effects, click the No Transition option. Click the 
Random Transition option if you want have different transition effects applied at random. 

The lower scroll list shows you the sound effects associated with the visual effect you have 4. 	
selected. Leave the sound as it is, select another, click the No Sound option at the beginning 
of the list to make the transition silent or click the Random Sound option if you want to 
have different sounds played at random for different transitions.

Click 5. 	  Preview to see how the transition looks and sounds.

Note: Choose Apply to all slides in this slide show to make changes to all loaded slides of 
the current Slide Show. 

Click 6. 	  OK to apply the selected effects.

Audio Options
Audio options tell Slide Show to play all the slide’s sounds and text, play either the sound or the text, 
or not to play them at all.

To set up audio options:

Click the 1. 	  Edit Transitions switch. The customizing option buttons appear on each 
slide.

Click the 2. 	  Transition Effect Options arrow button on the left edge of a slide to change the 
transition into that slide. The Transitions and Sounds dialog appears.

Transition Effect 
Options

Page Advance Options

Audio Options
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Click the 2. 	  Audio Options button for a slide you want to change.

Tell Slide Show what to do while this slide is showing:3. 	

Select •	 Play Sound to tell Slide Show to play the sound attached to this picture.

Select •	 Play Text to tell Slide Show to read the text of this picture out loud.

Turn both options off to tell Slide Show not to play the sounds attached to the picture and •	
not to read the text out loud.

Note: Choose Apply to all slides in this slide show to make changes to all slides of the 
current Slide Show.

Click 4. 	  OK to apply the changes.

Background Color

Slides in a Slide Show appear on a solid color background. You can change this color.

To change the background color for the current Slide Show:

From the 1. 	  Slide Show menu, choose Change Background Color.

Pick a color and click 2. 	  OK.

Background Music
You can make your favorite song the background music of your Slide Show. 
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To add soundtrack to your Slide Show:

Click 1. 	  Import background sound button. The Import from iTunes dialog appears.

Choose your favorite song from iTunes.2. 	

Click 3. 	  Import. The soundtrack title will appear in the Soundtrack tray.

Tip: To remove your background music, click the Remove background sound button. To 

change the current Soundtrack, add a new one.

Playing Your Slide Show
You can play your Slide Show to see all your pictures enlivened with the added effects.

To play your Slide Show:

Click the1. 	   Play Slide Show button.

If your page advance options are set up to wait for a click or keyboard key press, you 2. 	
need to click or press a key to advance the slides.

Note: You can also use Slide Show controls that will appear if you move your mouse 
during play. Use Next Slide and Previous Slide buttons to navigate through your 
Slide Show.

To stop a Slide Show while it is playing:

Click the Stop button, double-click anywhere on the screen, or press the Escape key on your 
keyboard. By default, Slide Show plays only once, but it can be played continuously until you 
manually stop it.

To play a Slide Show continuously: 

Choose the Loop (Play Continuously) command from the Slide Show menu so that the 
checkmark appears.

To play a Slide Show only once: 

Choose the Loop (Play Continuously) command from the Slide Show menu again so that the 
checkmark next to the command disappears.

Using Manual Advance 
Manual advance lets you advance the slides manually, while keeping your visual and sound transition 
effects in place. 

To use manual advance: 

From the 1. 	  Slide Show menu, choose Turn Manual Advance On. 

Play a Slide Show by clicking the 2. 	  Play Slide Show button. 

Click with the mouse or press any key on your keyboard (except 3. 	  Escape) to advance to the 
next slide. 

Note: Pressing the Escape key or double-clicking with the mouse will stop the Slide Show.
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Select one of these formats:2. 	

•	 Full Page prints each slide on a single separate page. Type the number of the slide you 
want to print in the Starting Slide box.

•	 Storybook prints two slides on each page

•	 Comic Book prints six slides on each page, with the slides placed in two columns. To 
print six slides on a page, select Comic Book and type 1 in the Starting Slide box and 
6 in the Ending Slide box, and then click Print. To print the next six slides, click the 
Print button again and type 7 in the Starting Slide box and 12 in the Ending Slide 
box, and so on.

•	 Card / Booklet prints 4 slides per page. Slides are placed in two rows, one of which 
is upside-down. When you have printed the page, you can fold it in four to make a fun 
greeting card. You can also print just one slide on the first panel and then write on the 
other panels. To print four slides on a page, select Card / Booklet and type 1 in the 
Starting Slide box and 4 in the Ending Slide box, and then click Print. To print the 
next four slides, choose Print again and type 5 in the Starting Slide box and 8 in the 
Ending Slide box, and so on.

•	 Thumbnail prints twenty-four slides on each page. To print twenty-four slides on a 
page, select Thumbnail and type 1 in the Starting Slide box and 24 in the Ending 
Slide box, and then click the Print button again. If your Slide Show is longer than 
that, click the Print button again and type 25 in the Starting Slide box and 48 in the 
Ending Slide box, and so on.

Printing Your Slide Show
You can print each slide of your Slide Show separately on its own page, or you can print small-sized 
slides on one page.

To print your Slide Show:

Click the 1. 	  Print button. The Print dialog appears.
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If you select3. 	   Full Page, Card / Booklet, Storybook, or Comic Book, you can also choose 
one of these orientations:

•	 Portrait prints the slides on a vertical page.

•	 Landscape prints the slides on a horizontal page.

Click 4. 	  Print to print the Slide Show.

Saving Your Slide Show
Slide Shows are saved in the My Slide Shows folder (inside the My Pictures folder) by default.

To save your Slide Show:

Click the 1. 	  Save Slide Show button.

Type a 2. 	  name for your Slide Show.

Click 3. 	  Save.

Exporting Your Slide Show
You can export your Slide Show to play it with or without Kid Pix. 

To export a Slide Show in 3D:

Click the 1. 	  Export to 3D button. The Export Slide Show As dialog appears.

Type a name for the exported Slide Show.2. 	

Navigate to where you want to save your exported Slide Show.3. 	

Make sure the “4. 	  Include 3D stereographic effects” checkbox is selected.

Click 5. 	  Save.

To export your Slide Show:

Choose 1. 	  Export from the File menu.

Type a name for the exported Slide Show.2. 	

Navigate to where you want to save your exported Slide Show.3. 	

Choose a 4. 	  Save as type:

Project •	 As QuickTime Movie can be played on any computer with or without Kid Pix. 
Use QuickTime Player to open and play your exported Slide Show.

•	 Slide Show To Go creates a folder with everything you need to play your Slide Show on 
a different computer with Kid Pix. Copy the folder to another computer then in the Slide 
Show part of Kid Pix, use the Open command from the File menu to open the Slide Show 
file in that computer’s version of Kid Pix. Kid Pix will find all the files it needs to open your 
Slide Show.

Click 5. 	  Save.

Note: If you have used 3D objects in your Slide Show and want to see them in 3D after 
exporting, make sure that the “Include 3D stereographic effects” option is selected. If 
you select the “Reduce the movie size” option, your Slide Show will be compressed so it 
can be viewed on your iPod®. If you select “Add to iTunes Library when exporting”, your 
movie will be added automatically to your iTunes library. To export your movie to a portable 
Apple device, follow the instructions in “Watching Your Movie on an Apple device” on page 
55. 
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Creating Animations from Your Slide Show
You can create simple animations using Slide Show projects you have created.

To set default animation options:

Choose 1. 	  Kid Pix Preferences from the Edit menu.

Open the 2. 	  Slide Show tab in the dialog that appears and choose No Transition from the 
Transition Effect pop-up menu.

Set the 3. 	  Timer interval to any value small enough for an animation. For example, to 0.1 
second.

Click 4. 	  OK.

To create an animation frame by frame:

Create a picture or open one you have already created.1. 	

Add an object or several objects (stickers, text, and so on) that you want to animate.2. 	

Click the 3. 	  Flipbook button. A new Slide Show will be created with your picture as a first 
slide.

Modify the added object or objects slightly (move and resize them, change the color, and 4. 	
so on).

Click 5. 	  Flipbook button again. Changed picture will appear in the Slide Show as a second 
slide.

Repeat steps 4-5 to create more frames for your animation.6. 	

Set or modify transition options as described in the 7. 	  “Customizing Your Slide Show” on page 
59.

Export your Slide Show to QuickTime Movie to get an animated cartoon. See 8. 	  “Exporting 
Your Slide Show” on page 65.
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Options for Parents and Educators
In this chapter you will learn about:

Setting Up Kid Pix Preference•	 s

•	 Administrating the Login Dialog

Controlling Soun•	 d

Setting Up Kid Pix Preferences
Using the Kid Pix Preferences dialog, you can specify different Kid Pix settings for each Kid Pix 
user.

To set up Kid Pix Preferences:

Choose 1. 	  Kid Pix Preferences from the Edit menu. The Kid Pix Preferences dialog appears.

In the 2. 	  General tab, you can specify the following settings.

Click the •	 Menu bar hiding on checkbox to have the menu bar automatically hidden when 
you are using Kid Pix Deluxe 3D.

If you do not want to see the Kid Pix movie every time you launch the application, select •	
the checkbox labeled Skip the Kid Pix movie on startup.

If you don’t want the Login dialog to appear, and you want your home •	 Documents folder 
set as the default location for saving files, select the Skip the Login dialog checkbox.

For the first text box you create, choose a font from the •	 Font pop-up menu, and a font 
size from the Size pop-up menu.

Use the •	 Credits pop-up menu to specify whether or not you want credits to be added at 
the end of your Movie or Slide Show and what information the credits should contain.
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Click the 3. 	  Drawing tab at the top of the dialog to open the Drawing pane and specify the 
sound and Text-to-Speech settings for your drawing tools.

Click the •	 Turn tool sounds on checkbox to turn sound effects on or off when you are 
using the tools and trays in Kid Pix Deluxe 3D.

Click the checkbox labeled •	 Play added music or sounds to turn on or off sounds  
attached to your pictures.

Select the checkbox labeled •	 Turn on Read-Aloud Text feature to hear the text from text 
boxes read aloud.

Click the 4. 	  Slide Show tab to open the Slide Show pane and select settings for your Slide 
Shows:

Select the checkbox labeled •	 Play sounds during Slide Show to hear the sounds 
attached to your pictures when you play your Slide Show.

Select the checkbox labeled •	 Read aloud text during Slide Show to hear text from text 
boxes read aloud when you play your Slide Show.

In the •	 Default Slide Show Settings group, choose default transition and sound effects 
from the corresponding pop-up menus. These effects will play when one slide is advancing 
to the next. From the Timer group, choose a time interval between slides. From the 
Background Color pop-up menu, choose a color to fill the screen behind your slides while 
your Slide Show is playing. These effects will be applied to new Slide Shows you create 
unless you change them manually.

Click the 5. 	  Help tab to open the Help pane and specify the following settings. 

Select the checkbox labeled •	 Provide coaching hints if no activity to make the coaching 
help active. 

Using the •	 Delay before hints pop-up menu, set the period of time after which the 
coaching help will start if there is no mouse or keyboard activity. 

Select the checkbox labeled •	 Turn automatic help tags on to see and hear helpful 
explanations for tools and buttons when you place your pointer over them. 

If you want to hear help tag text read out loud, click the checkbox labeled •	 Speak 
automatic help tag text after to turn the automatic help tag speaking feature on. From 
the pop-up menu, choose the time after which the text will be spoken out loud. 

Select the checkbox labeled •	 Read aloud alert messages to hear alert messages spoken 
out loud.

Click the 6. 	  Updates tab to open the Updates pane and select the following options.

Click the •	 Automatically radio button to check for updates automatically each time you 
launch Kid Pix when connected to Internet.

Click the •	 Manually radio button to check for updates only when you click the Check Now 
button.

Click 7. 	  OK to apply all the settings you have specified. 

Administrating the Login Dialog
Using the Login dialog, you can create multiple users or log in as a different user.
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Setting Up Multiple Users
For classroom use, or if lots of kids use the same computer, you can set up the application for 
multiple users.

To set up multiple users:

In the 1. 	  Login dialog, type KidPixAdmin and then click Go. For details on opening the Login 
dialog, see “Logging In as New Kid Pix User” below.

Type the names of new users and click 2. 	  Add after each one to add them to the list.

Click 3. 	  Done when you have finished.

To delete a user:

In the1. 	   Login dialog, type KidPixAdmin and then click Go.

Select an user name you want to remove.2. 	

Click 3. 	  Delete.

Click 4. 	  Done when you have finished.

Logging In as New Kid Pix User
If you have more than one Kid Pix user added, you can log in as any one of them any time you want 
while working with Kid Pix.

To log in as a new user:

Open the 1. 	  File menu and choose Log In as New Kid Pix User.

Select a user name from the list labeled 2. 	  Kid Pix user list.

Click 3. 	  Go.

Turning Off the Login Dialog
You can turn off the Login dialog that appears when you launch Kid Pix. 

Once the dialog is turned off, all Kid Pix documents you create will be saved by default to the home 
folder where your documents are stored.

To turn off the Login dialog:

Choose 1. 	  Kid Pix Preferences from the Edit menu.

Select the 2. 	  Skip the Login dialog option in the General tab of the dialog that appears.

Activating Small Kids Mode
Kid Pix has two modes: Normal Mode and Small Kids Mode. In Normal Mode, all the Kid Pix 
tools and features are active. In Small Kids Mode, complex features (like most of the menu 
options, Slide Show, and printing) are inactive. This lets younger children create freely, without 
confusion.

In Small Kids Mode, children can:

Use the all art tools.•	

Add text to a picture using rubber stamp letters, symbols, and numbers instead of the •	
keyboard. When a child clicks a character in the tray, Kid Pix says its name out loud.
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To turn Small Kids Mode on or off:

From the 1. 	  Go menu, choose Turn Small Kids Mode On.

To return to 2. 	  Normal Mode, choose Turn Small Kids Mode Off from the Go menu.

Controlling Sound
Using the Kid Pix Preferences dialog, you can turn on or off tool sounds, attached sounds, and 
Text-to-Speech effects for each user. For more information on controlling sound settings, see “Setting 
Up Kid Pix Preferences” on page 67.
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The Kid Pix Deluxe 3D Menus
In this chapter you will learn about:

The File Men•	 u

The Edit Men•	 u

The Import Men•	 u

The Share Menu•	

The Go Men•	 u

The Paint Zone Men•	 u

The Slide Show Men•	 u

The Help Men•	 u

The File Menu
New
Creates a new Kid Pix picture or Slide Show. For details, see “Starting Your New Picture” on page 51 
and “Starting Your Slide Show” on page 56.

Open
Lets you open an existing Kid Pix picture or Slide Show. Kid Pix first looks in the default My Pictures 
or My Slide Shows folders, but you can also browse through other folders on your computer. For 
details, see “Opening Your Picture” on page 52 and “Creating and Opening Slide Shows” on page 56.

Open Recent
Lists up to ten recently used Kid Pix pictures or Slide Shows for you to open them easily.

Idea Machine
Opens the Idea Machine dialog, where you can select a template picture. You can use the Idea 
Machine like an electronic coloring book. For details, see “Starting Your New Picture” on page 51.

Save
Saves an open picture or Slide Show. For details, see “Saving Your Picture” on page 51 and “Saving 
Your Slide Show” on page 65.

Save As
Lets you save an open picture or Slide Show to a selected location with a different name. For details, 
see “Saving Your Picture” on page 51 and “Saving Your Slide Show” on page 65.

Save As Template 
Lets you save an open picture as a template and add it to the Idea Machine. For details, see “Saving 
Your Picture As a Template” on page 52.

Export
Exports your picture or Slide Show in a different format. For details, see “Exporting Your Picture” 
on page 53 and “Exporting Your Slide Show” on page 65.

Send Kid Pix Page by Email
Opens the default email application and creates an email message with your Kid Pix artwork  
attached.
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Print
Prints an open picture or Slide Show. For details, see “Printing Your Picture” on page 53 and “Printing 
Your Slide Show” on page 64.

Log In As New Kid Pix User
When you log in as a different user, Kid Pix uses the settings and folder locations specific to this user.

Install Kid Pix DVD Contents 
Allows you to install all the contents of the application DVD on your hard disk. For details, see 
“Installing Kid Pix DVD Contents” on page 10.

Exit
Quits Kid Pix. You can also click the Exit button on the right side of the Paint Zone to quit.

The Edit Menu
Undo
Undo reverses the changes you made. For details, see “Using Multi-Level Undo Guy” on page 24.

Redo
Redo reverses the Undos. For details, see “Using Multi-Level Undo Guy” on page 24.

Cut
Removes the currently selected object and places it on the Clipboard.

Copy
Puts a copy of the currently selected object on the Clipboard.

Paste
Pastes the object from the Clipboard.

Select All Text
Selects all the text inside the selected text box. (Applies only to text boxes.)

Check Spelling
Checks the spelling in all the text boxes in your picture. (Applies only to text boxes.) For details, see 
“Checking Spelling” on page 28.

Check Spelling As You Type
Provides a dynamic spelling check while you are typing. (Applies only to text boxes.) For more 
details, see “Checking Spelling As You Type” on page 28.

Enlarge to Fill Canvas
Enlarges the currently selected object to fill the whole drawing area.

Kid Pix Preferences
Allows you to specify different settings of Kid Pix for each user.
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The Import Menu
From iTunes
Lets you import sounds from your iTunes library. For details, see “Importing Sounds from iTunes” on 
page 47.

Background
Lets you add a picture created in another application as a background for your Kid Pix picture. For 
details, see “To import a background” on page 34.

Graphic
Lets you add a graphic created in another application to your Kid Pix picture. For details, see “Adding 
Pictures” on page 46.

Movie File
Lets you import a movie to your Kid Pix picture. For details, see “Adding Movies” on page 48.

Video Narration

Lets you import your recorded movie. For details, see “Video narration” on page 44.

Sound
Lets you import and attach a sound from another source to your Kid Pix picture. For details, see 
“Adding Sounds” on page 46.

The Share Menu

YouTube

Publishes your movie to your YouTube account. For details, see “Publish to YouTube” on page 49.

The Go Menu
Go to Slide Show/Paint Zone
Switches you from Paint Zone to Slide Show and back. For details, see “Going to Slide Show” on 
page 56 and “Editing Pictures” on page 57.

Turn Small Kids Mode On/Off
Switches between the modes. For details, see “Activating Small Kids Mode” on page 69.

The Paint Zone Menu
Alphabet Text 

Lets you insert the text you want to paint with using the Letters Wacky Paint option. For details, see 
“Alphabet Text Tool” on page 26. 

Say It This Way
Lets you teach Kid Pix how to pronounce words it does not know, like names and places. For details, 
see “Teaching Kid Pix to Pronounce” on page 29.
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Flatten Text
Makes text boxes a part of the background. You can flatten just the selected text box or all text 
boxes in the picture. For details, see “Working with Text Boxes” on page 26.

Flatten Stickers & Animations
Makes stickers and animations a part of the background. You can flatten just the selected object or 
all stickers and animations in the picture. For details, see “Stickers Library” on page 34, “Animations 
Library” on page 36.

Flatten Movies
Makes movies a part of the background. You can flatten just the selected movie or all of them. For 
details, see “Adding Movies” on page 48.

Make Sticker

Creates a sticker from a selected frame of a movie or animation, a text object, or an area of the 
background you have cut out with the Scissors tool. For details, see “To create your own sticker” on 
page 36.

Add to Slide Show

Creates new Slide Show with current picture as a first slide or adds current picture as a last slide. For 
details see “Loading Pictures” on page 57.

The Slide Show Menu
Change Background Color
Lets you change the background color for your current Slide Show. For details, see “Background 
Color” on page 62.

Change Background Sound
Lets you change the background sound for your current Slide Show. For details, see “Background 
Music” on page 62.

Change Transition Effects
Lets you customize the transition effect options for your Slide Show. For details, see “Transition 
Effects” on page 60.

Load Picture
Places a picture in the selected slide of your Slide Show. For details, see “Loading 			
Pictures” on page 57.

Delete Blank Slides
Gets rid of blank slots in your Slide Show. For details, see “Deleting Blank Slides” on page 58.
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Loop (Play Continuously) 

Allows you to play your Slide Show in a loop. For details, see “Playing Your Slide Show” on page 63. 

Turn Manual Advance On or Off 

Changes the transition settings of your Slide Show so that you need to click or use your keyboard to 
advance to the next slide. For details, see “Using Manual Advance” on page 63. 

The Help Menu
Kid Pix User Guide
Opens this User’s Guide in your default PDF viewer. For details, see “Getting Help” on page 13.

Kid Pix Tutorials
Sends you to the online Kid Pix tutorial.

Turn Help Tags Off or On
Turns automatic help tags off or on. For details, see “Getting Help” on page 13.

Kid Pix Registration
Opens the Kid Pix Registration page in your default web browser.

Provide Kid Pix Feedback
Allows you to share your thoughts about Kid Pix with us. Choose this command to open the Kid Pix 
Feedback page in your default web browser.

Kid Pix Tech Support
Connects your web browser to the Kid Pix Technical Support web page. For details, see “Getting 
Technical Support” on page 80.

About Kid Pix 
Tells you about the current version of the application, its developer team, and credits.
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Keyboard Shortcuts

Control + ; Opens the Preferences dialog. For more information, see “Setting Up Kid Pix 
Preferences” on page 67.

Alt + F4 Exits Kid Pix Deluxe 3D.

Control + N Creates a new Kid Pix picture or Slide Show. For details, see “Starting Your New 
Picture” on page 51 and “Starting Your Slide Show” on page 56.

Control + O Opens a Kid Pix picture or Slide Show. For details, see “Opening Your Picture” on 
page 52 and “Creating and Opening Slide Shows” on page 56.

Control+Shift+O Loads a Picture to the Slide Show. 

Control + S Saves an open picture or Slide Show. For details, see “Saving Your Picture” on 
page 51 and “Saving Your Slide Show” on page 65.

Control +  
Shift + S 

Opens the Save Picture As or Save Slide Show As  dialog for you to save 
an open Kid Pix picture or Slide Show to a selected location with the name you 
specify.

Control + Alt + 
Shift + S

Opens the Save As Template dialog for you to save an open Kid Pix 
picture as a template and add it to the Idea Machine. For more information, see 
“Saving Your Picture As a Template” on page 52.

Control + P Opens the Print dialog for you to print the current picture or Slide Show. For 
details, see “Printing Your Picture” on page 53 and “Printing Your Slide Show” on 
page 64.

Control + Z Undoes the last action. For details, see “Using Multi-Level Undo Guy” on page 24.

Control + Shift + Z Redoes what have been undone, see “Using Multi-Level Undo Guy” on page 24.

Control + X Cuts the currently selected object and places it on the Clipboard. 

Control + C Puts a copy of the currently selected object on the Clipboard. 

Control + V Pastes the object from the Clipboard. 

Control + A Selects all the text inside a selected text box. For more information, see “Select 
All Text” on page 72.

Control + L Enlarges the currently selected object to fill the whole drawing area. 

Control + ? Turns the automatic help tags off or on. For more information, see “Getting Help” 
on page 13.

Alt Shows the menu bar.

Control + Shift + A Creates new Slide Show with current picture as a first slide or adds current 
picture as a last slide to the current Slide Show. For details see “Loading Pictures” 
on page 57.

Control + Shift + L Checks the spelling in all the text boxes in your picture. (Applies only to text 
boxes.) For details, see “Checking Spelling” on page 28.

Keyboard Shortcuts
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Frequently Asked Questions 
The questions and answers in this chapter include: 

Why do some things become a part of the background, while others remain separate?•	  

Can I save a Kid Pix picture or Slide Show in another format, so other people can see it?•	  

How can I set up multiple users and make the settings different for each one?•	  

How do I use the •	 Sound Art tool? 

What is the difference between •	 Rubber Stamps and Stickers? 

What is the difference between animations and animated •	 Wacky Paint or Moving Paints 
mode options? 

How can I see the 3D effect on my computer•	 ?

How can I open Kid Pix Deluxe 3X files in Kid Pix Deluxe 3D•	 ?

What should I do if I have made my Slide Show but I want to edit a slide•	 ?

How can I correct mistakes I have made•	 ?

How limited is the path animation area•	 ?

Q: Why do some things become a part of the background, while others remain separate? 

A: In Kid Pix, a picture is like a piece of paper with a layer of clear plastic over it. Things you add 
to the background cover each other, just as if you had painted them on a piece of paper. Objects 
like stickers, animations, sounds, movies, and text boxes float over the background, on the 
plastic layer. They remain independent until you flatten them. Flattening an object merges it into 
the background. 

You can pick up items on the plastic layer and move them, resize them, and (for animations, 
sounds, or movies) play them. 

Some actions cause things to flatten even if you do not flatten them yourself. For example, when 
you export a picture, the objects get flattened as a result, because the export format does not 
know how to display them otherwise. 

Q: Can I save a Kid Pix picture or Slide Show in another format, so other people can see it? 

A: To move a picture or Slide Show to another computer that has Kid Pix on it, save the picture to 
a mounted disk, or export the Slide Show as a “Slide Show To Go”. 

To move the picture or Slide Show to another computer without Kid Pix on it, export the file in 
a format the other computer can play. You can also share your movies by uploading them to     
www.youtube.com. For more information, see “Exporting Your Picture” on page 53, “Exporting 
Your Slide Show” on page 65 and “Publish to YouTube” on page 49. 

Q: How can I set up multiple users and make the settings different for each one? 

A: Log in as KidPixAdmin to set up multiple users. Then log in as each user in turn and specify 
Kid Pix settings for that user. For details, see “Logging In As New Kid Pix User” on page 69.

http://www.youtube.com/
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Q: How do I use the Sound Art tool? 

A: The Sound Art tool paints abstract images that get their size and shape from the pitch and 
volume of sounds you put in through your computer’s sound input device. Talk or sing into your 
computer’s microphone, and the Sound Art tool will “paint” those sounds. 

To select the Sound Art tool, click the Painting Tools button and click the Sound Art tool in the 
tray. Then select the “Hands-free” or “Mouse-move” mode in the tool options tray. 

If you select the “Hands-free” mode, you can make noise into the microphone and Kid Pix will 
paint itself. If you select “Mouse-move”, you can direct the painting with the mouse and make 
noise at the same time to form the painting. For details, see “Using Painting Tools” on page 16. 

Q: What is the difference between Rubber Stamps and Stickers? 

A: Rubber Stamps are pictures you “stamp” into your picture. They immediately get flattened into 
the background. You can edit rubber stamps using the Stamp Editor. You can’t edit the rubber 
stamps once you have added them to your picture. For details, see “Using Rubber Stamp Tools” 
on page 20.

Stickers are pictures you add to your Kid Pix picture that remain independent objects. You can 
move and resize them unless you flatten them. For details, see “Stickers Library” on page 34. 

Q: What is the difference between animations and animated Wacky Paint or Moving Paints 
mode options? 

A: Animations are stickers that move, like very small movies. Animations are played when you 
play your picture. Animations remain independent objects after you add them to your picture. 
You can move and resize them unless you flatten them. For details, see “Animations Library” on 
page 36.

The Wacky Paint mode options of Paint Brush and the Moving Paints mode options of Spray 
Can are Painting Tools that paint with magical effects. After you paint with them, they animate 
for a short period, then get flattened into the background. You can’t move or change what you 
create with the Wacky Paint mode options of Paint Brush or the Moving Paints mode options 
of Spray Can tool the way you can with an animation. For more information, see “Using Painting 
Tools” on page 16.

Q: How can I see the 3D effect on my computer?

A: To see the 3D effect, first you must export you project with the “Include 3D stereographic 
effects” option selected. After that, open the exported file in an appropriate application and look 
at it wearing a pair of the red-blue 3D glasses. See “Exporting Pictures with 3D Effects” on page 
54.

Q: How can I open Kid Pix Deluxe 3X files in Kid Pix Deluxe 3D?

A: Yes, you can open all files from the Mac version of Kid Pix Deluxe 3X in Kid Pix Deluxe 3D, all 
features are fully supportable.

Q: What should I do if I have made a Slide Show but I need to edit a slide?

A: You just have to double-click the slide you want to edit. The slide’s picture will open in the 
Paint Zone, where you can make all the changes you need. When you save your changes, the 
picture will automatically be updated in the Slide Show. For more information, see “Editing 
Pictures” on page 57.
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Q: How can I correct mistakes I have made?

A: Undo Guy will take you back as many steps as you need. For details, see “Using Multi-Level 
Undo Guy” on page 24.

Q: How limited is the path animation area?

A: It isn’t limited at all. Animation paths can even be drawn outside the canvas, although you 
won’t see the object when it is away from the drawing area. For more information on creating 
animation path, see “Path Animation Tool” on page 37.
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Getting Technical Support
To get Technical Support:

Choose Kid Pix Tech Support from the Help menu. Your web browser will take you to the Kid Pix 
Technical Support page.

If you cannot launch Kid Pix, you can go to The Software MacKiev Technical Support page by  
going to www.mackiev.com and following links to Support.

http://www.mackiev.com
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Index

A
Add a Background  33
Add a Frame to your Movie  45
Adding Text  25
Add to Category

my backgrounds  34
my sounds  42, 46, 47

Alphabet Text Tool  26
Animations

adding  36
copying  30
creating  from Slide Show  66
deleting  37
editing frame  36
flattening  37
flipping  37
library  36
library button  36
moving  30, 37
pause playing  37
playing frame-by-frame  37
playing in a loop  37
resizing  37
tray  36

Art Tools  15
Audio Options

button  61
play sound  62
play text  62

B
Background Color  62
Background Music  62
Backgrounds

adding  33
color for Slide Shows  62
library  33
removing from My Backgrounds  34
removing from picture  34
tray  33

Big eraser  23
Blank slides deleting  58
Blend of Colors Paint Bucket  19
BMP pictures

adding  46
exporting  53

Bold font style  27

C
Card / Booklet  64
Center at original size

for backgrounds  34
for pictures  46

Chalk  15
Change Background Color  62, 74
Change Transition Effects  61, 74
Check Spelling  28, 72
Check Spelling As You Type  28, 72
Circle Cutout  31
Close Sound Recording Tray button  41
Colors

choosing  22
Color Swatch  22
Comic Book  64
Cookie cutter  31
Copy command  58, 72
Copying

objects with Grab tool  30
slides  58
text  25

Crayon  15
Curved line drawing  16
Cut command  58, 72
Cutting

circles or ellipses  31
parts of a picture  31
polygon shapes  31
shapes  31
slides  58
squares or rectangles  31
text  25

D
Deleting

animations  37
backgrounds  34
blank slides in Slide Show  58, 74
movie  48
slides from Slide Show  58
sounds  41, 43
stickers  35
text boxes  27

Double soundtrack  42
Dragging slides in the Slide Show  58
Drawing

curved lines  16
paper texture  16, 22
rubber stamps  20

Drawing Tools
button  15
paper texture  16, 22
shapes  15

E
Edit frame

for animations  36
for stickers  35
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Index

for text  27
Edit menu  72
Enlarge to fill canvas  72, 76
Eraser in Stamp Editor  21
Erasers

effect options  23
shapes  23
sizes  23

Eraser Tools button  23
Erasing

parts of a picture  23
the entire picture  23

Exit  76
Exporting

as graphic  53
as QuickTime movie  54, 65
as Slide Show To Go  65
picture  53
Slide Shows  65
with 3D effects  54, 65

Extended Help  13
Eye Dropper  23

F
File menu  71
Fill canvas without shrinking/stretching

for backgrounds  34
for pictures  46

Firehose Screen Eraser  23
Flattening

animations  37, 74
movies  48, 74
text  27, 74

Flipbook  57
Flipping

animations  37
rubber stamps  21
stickers  35

Font
changing  27
setting  67

Formatting text  27
Free Cutout  31
Frequently Asked Questions  77
Full Page

printing picture as  53
printing Slide Show as  64

G
Getting

help  13
help tags  13
started  9
user guide  13

Go to
Paint Zone  57, 73
Slide Show  56, 73

Grab tray  30
Graphic formats  53

H
Help

getting  13
menu  75

I
Idea Machine  51, 71
Import

background  73
from iTunes  73
graphic  46, 73
menu  73
movie  48, 73
sound  42, 46, 73

Installing
installing Kid Pix  9
install Kid Pix DVD Contents  10

Italic font style  27

J
JPEG pictures

exporting as  53
importing as background  34

K
Keyboard Shortcuts  76
Kid Pix

customizing  67
getting started  9
getting technical support  75, 80
installing  9
launching  10
libraries  32
logging in  10
menus  71
preferences  67
removing  14
user guide  13, 75

KidPixAdmin  69, 77
Kid Pix movie

skip  67

L
Landscape orientation  65
Launching Kid Pix  10
Libraries  32
Library

buttons  32
trays  32

List of Voices pop-up menu  29
Loading

pictures  57, 74
Load picture icon  57
Logging in Kid Pix  10
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Index

Login dialog
skip  67

Loop
playing animation in a loop  38

M
Make Sticker  74
Marker  15
Mega Mixer  20
Menus

in Kid Pix  71
using  13

Mini Eraser  23
Mixers

effects  20
sizes  20
tray  20

Mixer Wand  20
Movies

adding  43, 48
deleting  48
flattening  48
moving  30, 48
playing  48
playing frame-by-frame  48
playing in a loop  48
resizing  48

Moving
animations  37
movies  30, 48
objects with Grab tool  30
pictures in Slide Show  58
stickers  35
text boxes  27

Multiple users
delete  69
frequently asked questions  77
setting up  69

N
Naming

pictures  51
Slide Shows  65

Narration
movie  44
sound  41
when narration ends  60

New
command  71
create new picture button  51
Slide Show button  56

Normal Mode  70

O
Object

resizing  30
Opening

pictures  52
Slide Show  57

P
Page advance options  59

customizing Slide Show  59
on mouse click  60
on pressing any key  60
timer  59
when narration ends  60
when text reading finishes  60

Paint Buckets
blend of colors paint bucket  19
button  18
multicolor pattern  19
solid  19
tray  18

Painting Tools
button  16
modes  16
sizes  16
texture  18, 22
tray  16

Paint Zone  11
menu  73

Paste button in tray  25
Paste command  58, 72
Pasting

in Slide Show  58
text  25
with Grab tool  30

Path Animation  37
Pencil

for Rubber Stamps  21
tool  15

Photographs
adding  46

PICT pictures
exporting as  54

Pictures
adding  46
deleting from Slide Show  58
exporting  53
new  51
pasting in Slide Show  58

Play
picture  52
Slide Show  63

Polygon Cutout  31
Portrait orientation  65
Preferences  67
Print

button  53, 64
command  72
orientation  65
picture  52
shortcut  76
Slide Show  64

Pronunciation
learning Kid Pix  29

Publish
to YouTube  49
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Index

Q
QuickTime

exporting as  54
exporting Slide Show as  65
movie  54

R
Redo command  72, 76
Removing Kid Pix  14
Repeat many times

for backgrounds  34
for pictures  46

Resizing
animations  37
movie  48
pasted object  30
text boxes  27

Restore Original button  21
Reversing actions  24, 72, 76
Rotating rubber stamps  21
Rubber Stamp Editor  21
Rubber stamps

adding  20
and stickers  78
changing  21

Rubber Stamp Tools button  20

S
Save As command  71
Saving

pictures  51
Slide Shows  65

Say It This Way  29, 73
Scrolling Slide Show  58
Select All Text  72, 76
Send by Email  71
Sending artwork  71
Setting up

multiple users  69
preferences  67

Share Menu
YouTube  73

Shortcuts Keyboard  76
Shrink/stretch to fill canvas

for backgrounds  34
for pictures  46

Skip Kid Pix movie  67
Skip the Login dialog  67
Slides

deleting  58
loading  57
moving  58
pasting  58

Slide Show  12
audio options  62
background color  62

background music  62
creating animations  66
creating new  56
customizing  59
deleting blank slides  58
exporting  65
exporting as QuickTime movie  65
exporting as Slide Show To Go  65
flipbook  57
frequently asked questions  77
loading pictures  57
menu  74
naming  56
opening  57
page advance options  59
printing  64
saving  65
scrolling  58
stop playing  63
transition effects  60
tray  57

Small Kids Mode
activating  69
turning on or off  73

Sound
when narration ends  60

Sound Art tool
frequently asked questions  78
mouse move mode  17
painting tools  17

Sound formats  42, 46
Sound Recording tray  41
Sounds

importing  42, 46
in Slide Show  62
library button  41
recording  41
removing from My Sounds  43
removing from picture  41
tray  41

Spelling
checking  28, 72
checking as you type  28, 72

Spray Can
moving paints mode  18
paint shapes mode  18

Square Cutout  31
Stamp Editor  21
Starting

new pictures  51
Slide Show  56
with the Idea Machine  51

Stickers
adding  34
copying  30
deleting  35
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Index

flipping  35
library button  35
moving  35
rubber stamps  78
tray  35

Stop Slide Show  63
Storybook printing  64
System requirements  6

T
Technical Support  80
Text

aligning  27
centering  27
changing size  27
changing style  27
check spelling  28, 72
check spelling as you type  28, 72
copying  25
cutting  25
options in Preferences  67
pasting  25
playing  28, 62
reading out loud  28
selecting all  72, 76
setting font  27, 67
tray  25
when text reading finishes  60

Text boxes
deleting  27
flattening  27
formatting text  27
moving  27
moving off page  27
resizing  27

Text style  27
Text Tools button  25, 27
Text-to-Speech

changing voice for  29
pronunciation  29
setting up  68

Thumbnail printing  64
Transition Effects  60, 74
Trash Can

in backgrounds tray  34
in Slide Show  58

Turning Off Login Dialog  69
Turn Small Kids Mode On or Off  70, 73
Tutorial  75

U
Underline font style  27
Undo

undo guy  24, 72, 76
User Guide  13, 75

V
Video Narration  44, 73

W
Wacky Paint mode

animations  78
painting  17
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